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1 Programmingin JScript

» JScript functionality in Axxon PSIM
« Description of the JScript object model in Axxon PSIM
« The Core object and its built-in methods
« The Core object
« The SetObjectParam method
« The SetObjectState method
» The DebuglogString method
» The Base64Decode method
« The Sleep method
« The Itv_var method
« The Int_var method
« The GetObjectParentType method
« The GetlPAddress method
« The GetObjectName method
« The GetObjectState method
« The GetObjectParam method
« The GetObjectParentld method
« The DoReactStr method
« The DoReact method
» The DoReactSetupCore method
« The DoReactSetup method
« The DoReactGlobal method
+ The NotifyEventStr method
+ The NotifyEvent method
+ The NotifyEventGlobal method
+ The CreateMsg method
« The Lock and Unlock methods
« The IsAvailableObject method
« The GetUserld method
« The GetEventDescription method
« The GetObjectldByParam method
« The SaveToFile method
» The GetLinkedObjects method
o The Writelni method
« The ReadIni method
« The AddIni method
o The SetTimer method
« TheKillTimer method
» The GetObjectChildlds method
» The Base64EncodeFile method
« The Base64EncodeW method
o The run_cmd and run_cmd_timeout methods
» The WritelniAny method
» The MsgObject and Event objects and their built-in methods and properties

+ The MsgObject and Event objects
« The GetSourceType method
» The GetSourceld method
« The GetAction method
« The GetParam method
o The SetParam method
+ The MsgToString method
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+ The StringToMsg method
» The StringToParams method
» The Clone method
« The GetObjectlds method
» The GetObjectParams method
« The SourceType property
« The Sourceld property
« The Action property
» Creating your first script
+ Script debugging
+ Script debugging features
+ Creating and using test events
+ Creating test events
+ Running the script with a test event
+ Using debugger windows of the Editor-Debugger utility
« Displaying messages about starting, verifying, changing and executing scripts in the debugger
windows
+ Viewing the script messages
+ Using third-party debugger programs
» Examples of scripts in JScript language
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+ Creating a script
+ Saving a script
Deleting a script
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+ Programming tools
« The Script object
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+ The Debug window
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+ Working with Debug window
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2 Appendix 1. Description of the Editor-Debugger utility

+ The purpose of the Editor-Debugger utility
+ Theinterface of the Editor-Debugger utility
+ The Editor-Debugger window

The Script Debug/Edit tab

» Description of the Script Debug/Edit tab

» The Script object panel in the Script Debug/Edit tab
The Script Messages tab

«» Description of the Script Messages tab

+ The Script object panel in the Script Messages tab
« Main menu
The Filter dialog window
The Color dialog window
The toolbar of the Editor-Debugger utility
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3 Appendix 2. Creating custom objects with ability to set events,
reactions and states

» Purpose of custom objects and their implementation in Axxon PSIM
» How to create a custom object

+ DBI file preparation

+ DDl file preparation

+ XML file preparation

+ Creating and using a custom object in Axxon PSIM
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4 Programming Guide (JScript). Conclusion

Programming Guide (JScript). Conclusion- 10



PSIM 1.0.0-1.0.1 (english) - Programming Guide (JScript)

5 Programming in JScript

5.1 JScript functionality in Axxon PSIM

The JScript programming language is used in Axxon PSIM to implement additional user functions not included in the
basic Axxon PSIM functionality.

JScript is a de-facto standard for developing and running user scripts. Axxon PSIM supports the version of JScript
based on ActiveX technology by Microsoft. The general description of the JScript object model is given in the
Microsoft documentation (for example, MSDN).

The JScript scripts in Axxon PSIM are executed using the standard ActiveX modules included in the Windows
operating system. So, any objects from the ActiveX-based JScript can be used in developing the scripts for Axxon
PSIM.

A set of specialized JScript objects is provided in Axxon PSIM for handling Axxon PSIM system objects, and for
sending and receiving system events and actions.

5.2 Description of the JScript object model in Axxon PSIM

5.2.1 The Core object and its built-in methods

The Core object

The Core object is a global static object providing the methods for monitoring and controlling the Axxon PSIM
system objects. Core methods allow receiving information about the existing objects, generating reactions for them
and changing their states. Core methods can pause script execution, script debugging, creating and calling global
variables.

The Core object is not a prototype, thus no other objects can be created on its base (it cannot be used as a
template). All Core methods are static. Thus, Core methods are called directly from the script with no need for a
Core prefix.

The SetObjectParam method
The SetObjectParam method sets the values of object parameters.

Method call syntax

function SetObjectParam(objtype: String, id: String, param : String, value : String)

Method arguments:

1. objtype - required argument. The type of the object whose parameters are to be set. It takes the following
values: Type - String, range - existing object types.

2. id - required argument. Identification number of the object of the type set in the objtype parameter. It takes
the following values: Type - String, range - existing object identification numbers of the specified type.

3. param - required argument. The parameter of the object. It takes the following values: Type - String, range
- available parameters of the object.

4. value - required argument. The value to be set for the parameter specified in the param argument. It takes
the following values: Type - String, range - depends on the parameter.

Usage examples

Programming in JScript- 11
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Example. When Macro 1 starts, check if Cameras 1 to 4 are set to broadcast color video. If a camera is set for black-
and-white video broadcast, then switch it to the color mode (setting the true (“1”) value to the “Color” parameter -
(“color™)).

if (Event.SourceType == "MACRO" && Event.SourceId == "1" && Event.Action == "RUN")
{

var i;
for(i=1; i<=4; q=i+1)
{
if (GetObjectParam("CAM", i , "color") == "0")
{
SetObjectParam("CAM", i, "color", "1");
}
}
}

() Note

If the object is active when the script is started (i.e. the setting panel of this object is open), then object
parameters can not be changed by the SetObjectParam method. For instance, if the setting panel for the
Camera 1 object is open and the aforecited script is started, the operation mode of Camera 1 will not be
changed for the color one.

The SetObjectState method
The SetObjectState method changes the state of objects.
Method call syntax

function SetObjectState(objtype : String, id : String, state : String)

Method arguments:

1. objtype - Required argument. The type of the object whose state is to be changed. It takes the following
values: Type - String, range - existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype parameter. It takes
the following values: Type - String, range - existing object identification numbers of the specified type.

3. state - Required argument. The state to switch the object to. It takes the following values: Type - String,
range - available states of the object.

Usage examples

Example. Check if Camera 1 is armed every hour. If Camera 1 is disarmed, arm it.

() Note

The Timer object with identification number 1 should be created beforehand. Set the Minutes parameter
of the Timer object to 30.The timer would go off every hour at half past the hour - 09:30, 10:30, 11:30, etc.

Programming in JScript- 12
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if (Event.SourceType == "TIMER" && Event.SourceIld == "1" && Event.Action == "TRIGGER")
{

if (GetObjectState("CAM", "1") == "DISARMED")

{

SetObjectState("CAM", "1", "ARMED");

}

}

The DebuglogString method

The DebuglLogString method outputs the user messages into the debug windows of the Editor-Debugger utility.
Method call syntax

function DebuglLogString(output : String)

Method arguments:

output - Required argument. The text message to be displayed in the debug window of the Editor-Debugger utility.
It takes the following values: Type - String.

Usage examples

Problem. Output to the debugger window all microphone events registered by the system.

if (Event.SourceType == "OLXA_LINE")

{

var msgstr = Event.MsgToString();
DebuglogString("Event from the microphone " + msgstr);

}

The Base64Decode method

The Base64Decode method is used for decoding the lines that are coded by Base64 scheme.

Method call syntax

function Base64Decode(data_in: String, WideChar: Boolean)

Method arguments:

1. data_in - required argument. Set a line that should be decoded in Base64;
2. WideChar - required argument. Determines coding type. Can take 0 or 1 values. If coding type is Unicode,
argument value is 1, otherwise 0.

Usage examples

Decode the line that is set in Base64 by starting macro Nel. Output the decoding result into the debug windows of
the Editor-Debugger utility. (Result is « Axxon PSIM JAVA SCRIPT» line).

if (Event.SourceType == "MACRO" && Event.SourceId == "1" && Event.Action == "RUN")

Programming in JScript- 13
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{
var str = Base64Decode("SW50ZWxsZWNOIEpTY3JpcHQ= ", 0);
DebuglLogString(str);
}
The Sleep method

The Sleep method pauses the execution of the script for a specified period of time.

Method call syntax

function Sleep(milliseconds : 1int)

Method arguments:

milliseconds - Required argument. The length of time that the script will be inactive for. Set in milliseconds. It
takes the following values: Type - int.

Usage examples

Problem 1. When Macro 1 starts, play the following audio files one by one: cam_alarm_1.wav, cam_alarm_2.wav,
cam_alarm_3.wav from the ...\Axxon PSIM\Wav\ folder. Set a 5 seconds (5000 milliseconds) delay before starting
each subsequent file.

if (Event.SourceType == "MACRO" && Event.SourceId == "1" && Event.Action == "RUN")

{

var 1i;

for(i=1; i<=3; i=1i+1)

{
DoReactStr ("PLAYER", "1", "PLAY_WAV", " file<\cam_alarm_" + i + ".wav>");
Sleep(5000);

}

}

Problem 2. When macro Ne2 starts, timer Nel, that triggers every 10 seconds in a minute after macro Ne2 starting,
starts.

() Note

To start this script create the Timer object with ID=1 beforehand. Leave object parameters set by default
(Any). The Timer 1 object can be disabled

if (Event.SourceType == "MACRO" && Event.SourceIld == "2" && Event.Action == "RUN")
{

for(i=0; i<=5; i=1i+1)

{

DoReactStr ("TIMER","1", "DISABLE", "");
Sleep(10000) ;

DoReactStr ("TIMER","1", "ENABLE", "");
NotifyEventStr ("TIMER","1", "TRIGGER", "");

}
DoReactStr("TIMER","1", "DISABLE", "");
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The Itv_var method
The Itv_var method sets and returns the values of global variables.

Method call syntax

function Itv_var (globalvar : String) : String

Globalvar - Required argument. The name of the global variable. It takes the following values: Type - String,
satisfying the rules for the names of the string parameters in the Windows registry.

Global variables are stored in the Windows registry to maintain their values after Windows restart. All global
variables are stored in the registry branch HKEY_USERS\S-1-5-21-...\Software\VMSScript\VMSSCRIPT and
HKEY_CURRENT_USER\Software\VMSScript\VMSSCRIPT. To access a global variable directly from the registry,
search the registry for it by its name.

Usage examples

Problem. When Macro 1 starts, save the value of the bright parameter of Camera 10 to the cam10bright global
variable. When Macro 2 starts, set the bright parameter of Cameras 1 to 4 to the value of the cam10bright global
variable.

if (Event.SourceType == "MACRO" && Event.Action == "RUN")

{

if(Event.Sourceld == "1")

{

Itv_var("caml@bright") = GetObjectParam("CAM", "10", "bright");

}

if (Event.SourcelId == "2")

{

var caml@bright = Itv_var("camlObright");
for(i=1; i<=4; i=1i+1)

{

SetObjectParam("CAM", i, "bright", caml@bright);

}
}
}

The Int_var method

The Int_var method sets and returns values of global variables of integer type.

A Attention!

The Int_var method uses the same storage as the Itv_var method, but modify the type of variable to the
integer type.

Method call syntax:
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function Int_var (globalvar : String) : -int

Globalvar - required argument. The name of the global variable. It takes the following values: type - String,
satisfying the rules for the names of the string parameters in the Windows registry.

() Note.

Global variables are stored in the system registry to maintain their values after Windows restart. All global
variables are stored in the registry branch HKEY_USERS\S-1-5-21-...\Software\VMSScript\VMSSCRIPT and
HKEY_CURRENT_USER\Software\VMSScript\VMSSCRIPT. To access a global variable directly from the
registry, search the registry for it by the same name.

Usage examples

To check the method operation in the following test example the value 1 sets to the "2" global variable and then
increases per 1 and displays on the script debug window.

if(Event.Action =="RUN")
{
Int_var(2) = 1;
Int_var("2")++;
DebuglLogString(Int_var("2").toString());
}

The GetObjectParentType method

The GetObjectParentType method returns the type of the parent object of the current object according to the
object hierarchy.

Method call syntax

function GetObjectParentType (objtype : String) : String

Method arguments:

objtype - Required argument. The type of the object whose parent’s type should be returned. It takes the following
values: Type - String, range - existing object types.

The Main object is the highest level object in the hierarchy. It is the parent for all objects of the Computer, Screen,
and other types.

Usage examples

Problem. When Macro 1 starts, display in the debugger window the names of four object types of higher hierarchical
order starting from the detection zone.

if (Event.SourceType == "MACRO" && Event.SourceId == "1" && Event.Action == "RUN")
{

var objtype = "CAM_ZONE";

DebuglogString(objtype);

for(var i = 1; i<=4; i=1i+1)

{
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objtype = GetObjectParentType(objtype);
DebuglLogString(objtype);

}

}

The GetIPAddress method

The GetIPAddress method returns the IP-address of the Axxon PSIM kernel according to current video surveillance
system architecture.

Method call syntax

function GetIPAddress (dst : String, src : String) : String

Method arguments:

1. dst- Required argument. The name of the remote computer where the Axxon PSIM kernel is installed. The
value of dst should correspond to one of the names of the computers registered during setup of the video
surveillance system. It takes the following values: Type - String, meeting the requirements for network
computer names; range - computer names existing in the system.

2. src - Required argument. The name of the local computer where the script executes. The value of src should
match the name of the local computer as it is registered in Axxon PSIM. It takes the following values: Type -
String; meeting the requirements for network computer names.

The information about all connections of the local computer (kernel) to other remote computers (kernels)
registered during the setup of the distributed architecture, is displayed in the Architecture tab of the System
Settings window.

Usage examples

Problem. Upon a camera alarm, determine the name of the server this camera is connected to, and output the IP-
address of the connection between this server and the local computer where the script executes, to the debugger
window.

if (Event.SourceType == "CAM" && Event.Action == "MD_START")

{

var camid = Event.Sourceld;

var compname = GetObjectParentId("CAM", camid, "COMPUTER");

var ip = GetIPAddress("wS1","wS1"); \\if the script is run on the computer where
kernel of Axxon PSIM software has been installed

DebuglogString("IP-address of the alarmed camera computer" + ip);

}

The GetObjectName method
The GetObjectName method returns the name of the object that it was given upon creation.

Method call syntax

function GetObjectName(objtype : String, id : String) : String

Method arguments:
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1. objtype - Required argument. The type of the object whose name is to be returned. It takes the following
values: Type - String, range - existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype parameter. It takes
the following values: Type - String, range - existing object identification numbers of the specified type.

Usage examples

Problem. In case of alarm in any sensor, open the information window with the following text: "Alarm in the
<alarmed sensor name> sensor connected to the <server name which the sensor is connected to> server”.

(@ Note

Create the information dialog window beforehand using the Arpedit.exe utility and save it as test.dlg in the
<Axxon PSIM>\Program folder.

if (Event.SourceType == "GRAY" && Event.Action == "ALARM")

{

var grayid = Event.Sourceld;

var grayname = GetObjectName("GRAY", grayid);

var compname = GetObjectParentId("GRAY", grayid, "COMPUTER");

DoReactStr ("DIALOG", "test", "CLOSE_ALL","");

DoReactStr ("DIALOG", "test", "RUN","Alarm in the '" + grayname + "' sensor connected
to the '" + compname + "' server.");

}

The GetObjectState method
The GetObjectState method returns the state of the object at the moment of method call.

Method call syntax

function GetObjectState(objtype : String, 1id : String) : String

Method arguments:

1. objtype - Required argument. The type of the object whose state is to be returned. It takes the following
values: Type - String, range - existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes
the following values: Type - String, range - existing identification numbers of the objects of the specified

type.
Usage examples

Problem. When Relay 1 activates (for example, on pressing the button connected to Relay 1), arm Sensor 1. The next
time Relay 1 activates, disarm Sensor 1.

if (Event.SourceType == "GRELE" && Event.Sourceld == "1" && Event.Action == "ON")
{

if(GetObjectState("GRAY", "1")=="DISARM")

{

SetObjectState("GRAY", "1", "ARM");

}

else
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{
SetObjectState("GRAY", "1", "DISARM");

}
}

() Note

Some object types can have several states at the same time. For example: ATTACHED|DISSOLVED or
ADDED|OFF|RECORDER_ON|RECORD.

The GetObjectParam method

The GetObjectParam method returns the value of the specified parameter of the object at the moment of method
call.

Method call syntax

function GetObjectParam(objtype : String, id : String, param : String) : String

Method arguments:

1. objtype - Required argument. The type of the object whose parameter’s value is to be returned. It takes the
following values: Type - String, range - existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes
the following values: Type - String, range - existing identification numbers of the objects of the specified

type.
3. param - Required argument. The name of the parameter whose value is to be returned. It takes the
following values: Type - String, range - available parameters of the object.

Usage examples

See the example for the SetObjectParam method.

The GetObjectParentld method
The GetObjectParentld method returns the identification number of the parent of the specified object.

Method call syntax

function GetObjectParentId(objtype : String, id : String, parent : String) : String

Method arguments:

1. objtype - Required argument. The type of the object whose parent’s identification number should be
returned. It takes the following values: Type - String, range - existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes
the following values: Type - String, range - existing identification numbers of the objects of the specified
type.

3. parent - Required argument. The type of the object which is the parent of the object type specified by the
objtype argument. It takes the following values: Type - String, range - existing object types.

Usage examples
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Problem. If a camera turns off or stops transmitting a video signal, send an e-mail message with the following
subject: "Warning! Camera turned off" and, in the message body, the number of the camera and of the server itis
connected to.

(@ Note

The Short Messages Service is supposed to be installed and working properly.

if (Event.SourceType == "CAM" && Event.Action == "DETACH")
{

var cam_id = Event.Sourceld;

var parent_comp_id = GetObjectParentId("CAM", cam_id, "SLAVE");

DoReactStr ("MAIL_MESSAGE","1" "SETUP","from<xx*@mail.com>,to<***@mail.com>,body<Came
ra disabling "+cam_id+" on the Server"+parent_comp_id+">,parent_id<1l>,subject<Attenti
on! Camera disabling>,name<Message 1>,objname<Message 1>");

DoReactStr ("MAIL_MESSAGE", '"1", "SEND", "'");

}

The DoReactStr method

The DoReactStr method generates the response actions for the objects. It sends the action to the specified object.
The action is transferred directly to the kernel where the object belongs, and not to the whole system. The action is
specified as a group of String arguments.

Method call syntax

function DoReactStr(objtype : String, id : String, action : String, param<value> [,
param<value>] : String)

Method arguments:

1. objtype - Required argument. The type of the object that the action should be generated for. It takes the
following values: Type - String, range - existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes
the following values: Type - String, range - existing identification numbers of the objects of the specified
type.

3. action - Required argument. The action to be generated. It takes the following values: Type - String, range -
available actions for the objects of the specified type.

4. param<value> - Required argument. Several arguments of this type can be specified. The parameters of the
action.

One parameter has the following syntax:
"param<value>", where

param - name of the parameter;

value - value of the parameter.

Several parameters have the following syntax:

"paraml<valuel>param2<value2>...

Elements of the list are separated by commas with no white space. If no parameters need to be specified, an empty
string is used:
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DoReactStr ("CAM","1","REC","");

The param argument can take the following values: Type - String, range - available parameters of the specified
action. The value argument can take the following values: Type - String, range - depends on the parameter.

For all reactions it is possible to specify delay of reaction performing using delay<> parameter. Delay is specified in
seconds.

() Note

Two types of system messages are available in the Axxon PSIM system: events and actions.

The events usually contain some information and are used as notifications sent to all Axxon PSIM kernels
connected to each other during the system setup.

The actions are the control commands sent to specific objects. An action is transmitted only to the kernel
where the related object belongs, and not to the whole system.

The DoReactStr and DoReact methods are used to generate actions. The NotifyEventStr and NotifyEvent
methods are used to generate events.

Usage examples

Problem. When an alarm is received from a camera, switch Monitor 1 to single window mode and show the video
from the alarmed camera in this window.

if (Event.SourceType == "CAM" && Event.Action == "MD_START")
{

var camid = Event.Sourceld;

DoReactStr ("MONITOR","1" ,"ACTIVATE_CAM","cam<"+ camid +">");
DoReactStr ("MONITOR","1" ,"KEY_PRESSED",'"key<SCREEN.1>");

}

Problem. When alarm by some camera is completed the record is to be continued for 5 second and after this time
the record will be stopped (analogue of Post-record mode).

if (Event.SourceType == "CAM" && Event.Action == "MD_STOP")
{

var camid = Event.Sourceld;

DoReactStr ("CAM",camid,"REC_STOP","delay<5>");

}

Problem. Use macros 1 to enable telemetry control using mouse on the camera 4 displayed in the monitor 10. Use
macros 2 to disable it.

if (Event.SourceType == "MACRO" && Event.Action == "RUN" && Event.Sourceld == "1")
{DoReaCtStr("MONITOR" ,"10" ,""CONTROL_TELEMETRY","cam<4>,0n<1>");

'j;f (Event.SourceType == "MACRO" && Event.Action == "RUN" && Event.Sourceld == "2")
{DoReaCtStr("MONITOR" ,"10" ,"CONTROL_TELEMETRY","cam<4>,0n<0>");

}
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The DoReact method

The DoReact method generates actions for the objects. It sends the action to the specified object. The action is
transferred directly to the kernel where the object belongs, and not to the whole system. The action is specified
using the MsgObject object.

Method call syntax

function DoReact(msgevent : MsgObject)

Method arguments:

msgevent - Required argument. The action sent to the specified object. It takes the following values: MsgObject
objects created earlier in the script.

() Note

Two types of system messages are available in the Axxon PSIM system: events and actions.

The events usually contain some information and are used as notifications sent to all Axxon PSIM kernels
connected to each other during the system setup.

The actions are the control commands sent to specific objects. An action is transmitted only to the kernel
where the related object belongs, and not to the whole system.

The DoReactStr and DoReact methods are used to generate actions. The NotifyEventStr and NotifyEvent

methods are used to generate events.

Usage examples

Problem. When Relay 1 closes, close Relays 2 and 3. When Relay 1 opens, open Relay 2.

if (Event.SourceType == "GRELE" && Event.Sourceld == "1")
{

var msgevent = Event.Clone();
if(Event.Action == "ON")

{

msgevent.Sourceld = "2";
DoReact(msgevent) ;
msgevent.Sourceld = "3";
DoReact(msgevent) ;

}

if(Event.Action == "OFF")

{

msgevent.Sourceld = "2";
DoReact(msgevent) ;

}
1

The DoReactSetupCore method

The DoReactSetupCore method is used for changing the parameters of the object. It changes only the specified
parameters, leaving other parameters intact.

Method call syntax
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function DoReactSetupCore(objtype : String, id : String, param<value> [,
param<value>] : String )

Method arguments

1. objtype - Required argument. The type of the object whose parameters are to be changed. It takes the
following values: Type - String, range - existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes
the following values: Type - String, range - existing identification numbers of the object of the specified

type.
3. param<value> - Required argument. Several arguments of this type can be specified. The parameters of the
action.

One parameter has the following syntax:
“param<value>", where

param - name of the parameter;

value - value of the parameter.

Several parameters have the following syntax:
“paraml<valuel>param2<value2>...”.

Elements of the list are separated by commas with no white space.

The param argument can take the following values: Type - String, range - available parameters of the specified
action. The value argument can take the following values: Type - String, range - depends on the parameter.

Usage examples

Problem. When Macro 1 starts, set the values of the following parameters of Cameras No1-4: PTZ device number
(telemetry_id) and synchronous microphone number (audio_id). The values should be equal to the camera
numbers plus 1.

if (Event.SourceType == "MACRO" && Event.Sourceld == "1" && Event.Action == "RUN")
{

var 1i;

for(i=1; i<=4; i=i+1)

{

DoReactSetupCore ("CAM", i, "telemetry_id<" + (i+1) +">,audio_id<" + (i+1l) + ">");
}
}

The DoReactSetup method

The DoReactSetup method is used for temporary changing parameters of the object. It changes only the specified
parameters, leaving other parameters intact.

Method call syntax
function DoReactSetup (objtype : String, id : String, param<value> [, param<value>]
String )

Method arguments:
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1. objtype - required argument. The type of the object the parameters of which are to be changed. It takes the
following values: type - String, range - existing object types.

2. id - required argument. Identification number of the object of the type set in the objtype argument. It takes
the following values: type - String, range - existing identification numbers of the objects of the specified

type.
3. param<value> - required argument. Several arguments of this type can be specified. The parameters of the
action.

One parameter has the following syntax:
“param<value>”, where

param - name of the parameter;

value - value of the parameter.

Several parameters have the following syntax:
“paraml<valuel>param2<value2>...”.

Elements of the list are separated by commas with no white space.

The param argument can take the following values: values of the String type, range is limited by available
parameters of the specified action. The “value” argument can take the following values: values of the String type,
the range depends on the parameter.

Example. When Macro 1 starts, temporary remove all cameras on the first monitor.

if (Event.SourceType == "MACRO" && Event.SourceId == "1" && Event.Action == "RUN")
{

DoReactSetup ("MONITOR","1","REMOVE_ALL","");

}

The DoReactGlobal method

The DoReactGlobal method is used to generate object reactions. The DoReactGlobal method transmits a reaction to
the required object. The reaction is transmitted not only to the kernel, where the object is registered, but to the
whole system. For the DoReactGlobal method the reaction is specified by the MsgObject object.

Method call syntax

function DoReactGlobal(msgevent : MsgObject)

Method arguments:

msgevent - required argument. It sets a reaction transmitted to the required object. It takes the following values:
MsgObiject objects created earlier in the script.

Example. When macro 2 starts, guard on Sensor 2. The command is to be transmitted to all system kernels as the
reaction to be registered in the Events Log.

if (Event.SourceType == "MACRO"&& Event.Sourceld == "2" && Event.Action == "RUN")
{

var msgevent = CreateMsg();

msgevent.SourceType = "GRAY";

msgevent.Sourceld = "2";
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msgevent.Action = "ARM";
DoReactGlobal(msgevent);
}

The NotifyEventStr method

The NotifyEventStr method generates system events. Events are sent to all kernels connected to the local kernel. An
event is specified as a group of String arguments.

Method call syntax

function NotifyEventStr(objtype : String, id : String, event : String, param<value>
[, param<value>] : String )

Method arguments:

1. objtype - Required argument. The type of the object that the event should be generated for. It It takes the
following values: Type - String, range - existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes
the following values: Type - String, range - existing identification numbers of the object of the specified
type.

3. event - Required argument. The event to be generated. It takes the following values: Type - String, range -
available events for the objects of the specified type.

4. param<value> - Required argument. Several arguments of this type can be specified. The parameters of the
event.

One parameter has the following syntax:
"param<value>", where

param - name of the parameter;

value - value of the parameter.

Several parameters have the following syntax:

"paraml<valuel>param2<value2>...".

Elements of the list are separated by commas with no white space. If no parameters need to be specified, an empty
string is used:

DoReactStr ("CAM","1" "MD_START","");

The param argument can take the following values: Type - String, range - available parameters of the event. The
value argument can take the following values: Type - String, range - depends on the parameter.

( Note

Two types of system messages are available in the Axxon PSIM system: events and actions.

The events usually contain some information and are used as notifications sent to all Axxon PSIM kernels
connected to each other during the system setup.

The actions are the control commands sent to specific objects. An action is transmitted only to the kernel
where the related object belongs, and not to the whole system.

The DoReactStr and DoReact methods are used to generate actions. The NotifyEventStr and NotifyEvent
methods are used to generate events.
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Usage examples

Problem. When an alarm is received, send the “panic lock” event corresponding to the camera region. For camera
identification numbers from 1 to 4, use region 1; for camera numbers from 5 to 10, use region 2.

if (Event.SourceType == "CAM" && Event.Action == "MD_START")
{

var regionid;

if (Event.Sourceld <=4)

{
regionid = "1";
}
if ((Event.Sourceld > 4) && (Event.Sourceld <= 10))
{
regionid = "2";
}
NotifyEventStr ("REGION", regionid, "PANIC_LOCK", "");
}
The NotifyEvent method

The NotifyEvent method generates system events. The event is sent to all kernels connected to the local kernel. The
event is specified using the MsgObject object.

Method call syntax

function NotifyEvent(msgevent : MsgObject)

Method arguments:

msgevent - Required argument. The event sent to the system. It takes the following values: MsgObject objects
created earlier in the script.

() Note

Two types of system messages are available in Axxon PSIM system: events and reactions.

The events usually contain some information and are used as notifications sent to all Axxon PSIM kernels
connected to each other during the system configuration.

The reactions are the control commands sent to specific objects.

The reactions are transmitted only to the kernel where the object belongs, and not to the whole system.
The DoReactStr and DoReact methods are used to generate reactions. The NotifyEventStr and NotifyEvent
methods are used to generate events.

Example. When the Backup Archive 1 module starts archiving video recordings, the analog output 1 of the Video
Capture Device 2 is disabled. Send the command as an event to be registered in the Events Log.

(@ Note

While executing this script, the analog output 1 of the Video Capture Device 2 is not disabled.
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if (Event.SourceType == "ARCH" && Event.Sourceld == "1" && Event.Action == "ACTIVE
ll)

{

var msgevent = CreateMsg();

msgevent.SourceType = " GRABBER ";

msgevent.Sourceld = "2";

msgevent.Action = "MUX1_OFF";

NotifyEvent(msgevent);

The NotifyEventGlobal method

The NotifyEventGlobal method is used to generate system events. The generated event is transmitted to all system
kernels connected via the net. For the NotifyEventGlobal method the event is specified using the MsgObject object.

Method call syntax

function NotifyEventGlobal (msgevent : MsgObject)

Method arguments:

msgevent - required argument. It sets the event transmitted to the system. It takes the following values: MsgObject
objects created earlier in the script.

Example. When Macro 1 starts, the first camera is set for recording. The command is to be transmitted to all system
kernels as the event to be registered in the Events Log.

() Note

While executing this script, cameral is not set for recording.

if (Event.SourceType == "MACRO"&& Event.Sourceld == "1" && Event.Action == "RUN")
{

var msgevent = CreateMsg();
msgevent.SourceType = "CAM";
msgevent.Sourceld = "1";
msgevent.Action = "REC";
NotifyEventGlobal(msgevent);
}

The CreateMsg method
The CreateMsg method creates objects based on the MsgObject prototype.
Method call syntax

function CreateMsg() : MsgObject

Method arguments: no arguments.

Programming in JScript- 27



PSIM 1.0.0-1.0.1 (english) - Programming Guide (JScript)

Usage examples

Problem 1. When an alarm is received, send the “panic lock” event corresponding to the camera region. For camera
identification numbers from 1 to 4, use region 1, for camera numbers from 5 to 10, use region 2.

if (Event.SourceType == "CAM" && Event.Action == "MD_START")
{

var msgevent = CreateMsg();

msgevent.SourceType = "REGION";

msgevent.Action = "PANIC_LOCK";

if (Event.Sourceld <=4)

{

msgevent.Sourceld = "1";

}

if ((Event.Sourceld > 4) && (Event.SourceId < 10))
{

msgevent.Sourceld = "2";

}

NotifyEvent(msgevent);
}

Problem 2. When timer Nel starts, start macro Nel every 30 seconds.

() Note

To start this script create the Timer object with ID=1 beforehand. Set value=1 to the Second parameter of
the Timer object, leave other parameters without changing («Any by default)

if (Event.SourceType == "TIMER" && Event.SourceId == "1" && Event.Action == "TRIGGER")
yp
{
var msg = CreateMsg();
msg.StringToMsg(GetObjectParams ("TIMER", "1"));
if(msg.GetParam("s") == "1")
{
DoReactStr(""MACRO", "1", "RUN", "");
SetObjectParam("TIMER","1","s","30");
DoReactStr("TIMER","1", "DISABLE", "");
DoReactStr ("TIMER","1", "ENABLE", "");
}
if(msg.GetParam("s") == "30")
{
DoReactStr ("MACRO", "1", "RUN", "");
SetObjectParam("TIMER","1","s","1");
DoReactStr ("TIMER","1", "DISABLE", "");
DoReactStr ("TIMER","1", "ENABLE", "");
}
}
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The Lock and Unlock methods

The Lock and Unlock methods are used to create a global critical section when synchronization of scripts started in
different streams is required. The Lock method opens a critical section and the Unlock method closes it.

& Attention!

Attention! If the Lock method has been called, then the Unlock method has to be called too. Otherwise the
system can freeze.

It is recommended to avoid using the Lock and Unlock methods.

Method call syntax

function Lock()

function Unlock()

Example. When Macro 1 starts, calculate total alarmed relays and sensors. Objects of each type are to be calculated
at the same time (in an individual script). The result is to be stored to “counter” global variable.

Script 1:

// Number of alarmed relays 1is calculated

var i = Number (0);

if (Event.SourceType == "MACRO" && Event.SourceId== "1" && Event.Action == "RUN")

{

var msg = CreateMsg();

msg.StringToMsg(GetObjectIds ("GRELE"));

var objCount = msg.GetParam("id.count");

var k;

for(k= 0; k < objCount; k++)

if(GetObjectState("GRELE", msg.GetParam("id." + k))== "ALARM"){
Lock();
i = Itv_var("counter");

i++;

Itv_var("counter")=1;

Unlock();

}

}

Script 2:

//Number of alarmed sensors is calculated
var i = Number(0);
if (Event.SourceType == "MACRO" && Event.Sourceld== "1" && Event.Action == "RUN")
{
var msg = CreateMsg();
msg.StringToMsg(GetObjectIds ("GRAY"));
var objCount = msg.GetParam("id.count");
var k;
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for(k = 0; k < objCount; k++)
if (GetObjectState("GRAY", msg.GetParam("id." + k))== "ALARMED"){

Lock();
i = Itv_var("counter");

++;

Itv_var("counter")=1;
Unlock();

}
}

®

Note

If the Lock() and Unlock() methods are not used in this example, then collisions may occur and calculated

value will be less than a real one

The IsAvailableObject method

The IsAvailableObject method is used to determine the current access rights to an object.

Method call syntax:

function IsAvailableObject(compname: String, objtype: String, id: String, param :
String) : String

The method returns 0 if the current user has not been assigned access rights of type param for the object; it returns
1 if these rights have been assigned.

Method arguments:

1.

compname - required. Corresponds to the name of the Computer object on which the object was created in
the hardware tree.
objtype - required. Corresponds to the type of the system object to which access rights are are being
checked. Allowed values: String type; the set of values is restricted to the object types registered in the
system.
id - required. Corresponds to the identification (registration) number of the object of the type specified by
the objtype argument. Allowed values: String type; the set of values is restricted to the identification
numbers of objects of the specified type, which are registered in the system.
param - required. Corresponds to the number of the type of rights which are being checked. A description of
rights is given in Limiting access to the system objects administration, control and viewing functions of the
Administrator’s Guide. Allowed values:
a. 0-NoView access rights. The method will return 1 if there are no administrative, control-, or viewing
rights for the object (red 'x').
b. 1-NoControl access rights. The method will return 1 if there are only viewing rights (letter M).
c. 2-ViewAndControl access rights. The method will return 1 if there are control- and viewing rights for
the object (green box).
d. 3-ViewOrControl access rights. The method will return 1 if there is either viewing or control rights for
the object.
e. 4-Not access rights (e.g. no access rights).
f. 5- Configure access rights. The method will return 1 if there are administrative, control- and viewing
rights for the object (gray box).

For example: Based on a Computer object named "S-UYUTOVA", a Camera object with the identifier 1 has been
created in the hardware tree. To determine the current access rights to the object:
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var i = 0;
for(i = 0; 1 <= 5; i++)
{

var result =
IsAvailableObject('S-UYUTOVA','CAM',"'1"', 1);

DebuglLogString("right "+i+" = "+result);

The GetUserld method

The GetUserld method returns the identifier of the current Axxon PSIM Software System user.

Method call syntax:

function GetUserId (cmp : String) : String

Method arguments:

1. cmp - required. Specifies the name of the computer on which the Axxon PSIM Software System is installed.
Allowed values: values of String type that satisfy the requirements for computers' network names; the set of
values is restricted to the names of computers registered in the system.

For example: To display the identifier of the current user of the Axxon PSIM Software System, which has been
installed on a computer named 'WS3":

DebuglLogString(GetUserId("wS3"));

The GetEventDescription method
The GetEventDescription method is in use for receiving the object description on free language.

Syntax of method invocation:

function GetEventDescription (obj_type : String, event : String)

Method arguments:

1. obj_type - required argument. Specifies type of system object description of which is required to get.
2. event - required argument. Specifies the name of object description of which is required to get.

Example. Display messages about receiving of events for camera 1 on the free language in the Debug window.

if (Event.SourceType == "CAM"&& Event.Sourceld == "1")
{

Programming in JScript- 31



PSIM 1.0.0-1.0.1 (english) - Programming Guide (JScript)

var str = GetEventDescription("CAM", Event.Action);
DebuglLogString(str);

The GetObjectldByParam method

The GetObjectldByParam method allows receiving of object ID at which some parameter is equal to the specified
value. The first found object ID is receiving if there are several such objects. The nullis receiving if such objects are
not found.

Syntax of method invocation:

function GetObjectIdByParam (obj_type : String, obj_param : String, param_value :
String)

Method arguments:

1. obj_type - required argument. Specifies type of system object, ID of which is required to get.

2. obj_param - required argument. Specifies the name of parameter in database on value of which the object
is to be found.

3. param_value - required argument. Specifies the required value of object parameter.

Example. Find cameras from which black-and-white image is receiving and set the Color parameter equals to 1 for
them.

if (Event.SourceType == "MACRO" && Event.Sourceld== "1" && Event.Action == "RUN")

{
var id = GetObjectIdByParam("CAM","color","0"); //receiving the first object ID
while (id){ //while exist the Camera objects from which black-and-white image is
receiving
SetObjectParam ("CAM", id, "color", "1"); //change the Color parameter for found
object
id = GetObjectIdByParam("CAM","color","Q@"); //receiving the next object ID
}
}

The SaveToFile method

SaveToFile method is in use to save in file the frame from camera receiving in the data parameter of FRAME_SENT
event.

Syntax of method invocation:

function SaveToFile (path: String, data: String, param : Boolean)

Saving of frame is also can be performed using the GET_FRAME reaction of the CAM object. It is required to specify
the path for saving file with frame in the path parameter of this reaction. FRAME_SENT event is created in the
system if the GET_FRAME reaction has not got the path parameter. In the data parameter of the FRAME_SENT event
the video image frame which is to be saved using the SaveToFile method is stored.

The reaction allows exporting of video image frame even if the camera is not displaying in the Monitor window.
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Method argument:

1. path - mandatory argument. Specifies the full path to save the file with frame.
2. data - mandatory argument. Specifies data to save in file.
3. param - mandatory argument. Defines necessity of conversion from base 64 format before saving. Possible
parameter values:
a. true - decode from base64 before saving;
b. false - save string without conversion.

Time of frame saving depends on the anchor frames frequency. The higher the anchor frames frequency, the less
time.

Example. Save the frame receiving from Camera 1 in the test.jpg file on the D disk:

if (Event.SourceType == "CAM" && Event.SourceIld == "1" && Event.Action ==
"FRAME_SENT")

{

SaveToFile("D:\\test.jpg",Event.GetParam("data"),true);

}

The GetLinkedObjects method

The GetLinkedObjects method is used to get list of objects linked to the specified camera using the Objects
connection object (see Connection of objects with cameras).

Method call syntax:

function GetLinkedObjects(typel : string, id : string, type2 : string)

Method argument:

1. typel - the type of object for which linked objects are to be returned.

2. id - identification number of object for which linked objects are to be returned.

3. type2 - the type of linked objects which are to be returned. If empty string is sent then linked objects of all
types will be returned.

Example.

The Objects connection object is configured the following way:
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Display in debug window the list of objects linked with the camera 1.

if (Event.SourceType == "MACRO")

{

varmsgstr = GetLinkedObjects("CAM","1","MACRO")
DebuglLogString("Linked objects " + msgstr);

}

As aresult the "Linked objects MACRO:1" message will be displayed in the script debug window.

The Writelni method
The Writelni method is used for writing the string variable to ini-file.

Method call syntax:

function WriteIni(varName: String, varValue: String, path: String)

Method argument:

1. varName - required argument. Sets name of variable for saving in the file.
2. varValue - required argument. Sets value of t variable.
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3. path - required argument. Sets full path to the ini-file in which variable is to be stored. Storage of variables
can be replaced on the network resource. Enter the network path in the argument for it.

Example. Write the MyVar variable to the \\fs\temp\test.ini file and specify the «Hello world!” value to it. Then read
the written value and display it on the script debug window.

WriteIni("MyVar", "Hello world", "\\\\fs\\temp\\test.ini");
var result = ReadIni("MyVvar","\\\\fs\\temp\\test.ini");

DebuglLogString(result);

The ReadIni method
The Readlnimethod is used to read values of string variablein the ini-file.

Method call syntax:

function ReadIni (varName: String, path: String): String

Method call syntax:

1. varName - required argument. Sets name of the variable storing in the file.
2. path - required argument. Sets the full path to the ini-file in which variable is storing.

See example in The Writelni method section.

The AddIni method

The AddIni method is used to write, change and read integer variable from the ini-file. The method returns the value
of variable after its changing.

Method call syntax:

function AddIni(varName: String, varValue: 1int, path: String): int

1. varName - required argument. Sets the name of variable in the file.
2. varValue - required argument. Sets the value of variable or value which should be added to the existing
value of variable:
a. ThevarValue value will be assigned to the variable if there is a file with the varName name and string
value in the file.
b. Ifthereis no variable with the varName name in the file then such variable will be created and the
varValue value will be assigned to it.
c. Ifthereis avariable with the varName name in the file and it has integer value or its value is
indicated to the integer type, then value will be indicated and the varValue value will be added to it.
3. path - required argument. Sets the full path to the ini-file in which variable it to be stored. Storage of
variables can be placed on the network resource. Enter the network path in the for it.

Example. There is no the "MyVar" variable in the "C:\\test.ini". Write such variable with the -1 value to the file, then
add 1 to it and display the result value on the script debug window.

var result = AddIni("Myvar", -1, "C:\\test.ini");
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result = AddIni("MyVar", 1, "C:\\test.ini");

DebuglLogString(result);

The SetTimer method

The SetTimer method is used to start the timer.
The syntax for accessing the method is:

function SetTimer (id : int, milliseconds : 1int)

Method arguments:

1. idis arequired argument. It specifies the timer ID. Allowed values are int or string type.
2. milliseconds is a required argument. It specifies the period with which the timer will trigger if it is not
stopped by the KillTimer method. It is specified in milliseconds. Allowed values are int type.

Example. 2 seconds after the macro 1 is executed, start recording on camera 1.

if(Event.SourceType=="LOCAL_TIMER" && Event.Action=="TRIGGERED" &&
Event.SourceId==333) //it is possible to use Event.SourceId == "333", i.e. string ID
{

var actuallyKilled = KillTimer(333);

if(actuallyKilled == 1)

{
DoReactStr ("CAM" "1" "REC","");

}
}
if(Event.SourceType=="MACR0"&& Event.Sourceld == "1" && Event.Action == "RUN")
{

SetTimer(333,2000); //333 - id, 2000 msec = 2 sec - period
}

The KillTimer method

The KillTimer method is used to stop the timer. Returns 1 if timer was stopped as a result of function executed.
The syntax for accessing the method is:

function KillTimer (id : 1int) : 1int

Method arguments:
1. idis a required argument. It specifies the timer ID. Allowed values are int or string type.

Example. See in the The SetTimer method section.

The GetObjectChildlds method
The GetObjectChildlds method returns IDs of child objects of specified type created under given object.
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Method call syntax

function GetObjectParentId(parent : String, id : String, objtype : String) : String[]

Method arguments:

1.

2.

parent - Required argument. The type of the object for which you want to find out child objects. It takes the
following values: Type - String, range - existing object types.

id - Required argument. Identification number of the object of the type set in the parentargument. It takes
the following values: Type - String, range - existing identification numbers of the objects of the specified
type.

objtype - Required argument. The type of the child objects whose identification numbers should be
returned. It takes the following values: Type - String, range - existing object types.

Example. Arm all cameras on WS2 computer on Macro 1.

if (Event.SourceType == "MACRO" && Event.Action == "RUN" && Event.Sourceld == "1")

{

var children = GetObjectChildIds("SLAVE","DESKTOP-UBOS6BK","CAM");
ch=children.split(",");
for (i=0;1i<ch.length; i++ )

{

DoReactStr ("CAM",ch[i],"ARM","");

}

}

The Base64EncodeFile method

The Baseb4EncodeFile method encodes a file to Base64. The method returns a string.

See also The Base64Decode method and The SaveToFile method.

Method call syntax:

function Base64EncodeFile (data_in: String): String

Method arguments:

1. data_in - required argument. Sets a path to the file to be encoded.

Example. At running Macro 1, encode 1.bmp to Base64 and save it to 2.bmp.

if (Event.SourceType == "MACRO" && Event.Sourceld == "1" && Event.Action == "RUN")

{

var s = Base64EncodeFile("d:\\1.bmp");
SaveToFile("d:\\2.bmp",s, true);

The Base64EncodeW method

The Base64EncodeW method encodes a Unicode string to Base64. The method returns a string.
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See also The Base64Decode method.

Method call syntax:

function Base64EncodeW (data_in: String): String

Method arguments:
1. data_in - required argument. Sets a string to be encoded.

Example. Dencode a Unicode string to Base64 then encode back and put to the debug log.

var test =

Base64Decode (
""MAAZACOAMAA3ACOAMgAWADEAOQAgADEANQAGADMAOQAGADQAMAAGAAOACEBOAGUACWBOACAAMQANAAOAMAAZ
ACOAMAA3ACOAMgAWADEAOQAgADEANQAGADQAMgAGADIAMQAGAAOACZBOAGUACWBOACAAMEA="" true) ;

DebuglLogString("----- >"+test);
var res = Base64EncodeW(test);
DebuglLogString("----- >"+res);

If the Base64Decode method received the "true" parameter, the script will have the following output:

03-07-2019 15:39:40:
test 1
03-07-2019 15:42:21:
test 2

The run_cmd and run_cmd_timeout methods
The run_cmd method is intended to execute commands on the command prompt from a script.

The run_cmd_timeout method is intended to execute commands on the command prompt with the process
termination timeout.

When invoking commands, the command prompt window does not open, i.e. the commands are executed in silent
mode.

The syntax for calling methods is as follows:

function run_cmd (cmd: String)
function run_cmd_timeout (cmd: String, timeout: -[int)
Method arguments:

1. cmdis a command prompt command.
2. timeout (only for run_cmd_timeout) is a timeout for process to terminate after the command execution.

Example 1. Run the curl utility and send a POST request with the text "Hello" to the test URL https://postman-
echo.com/post

var s = run_cmd("curl --request POST --url https://postman-echo.com/post --data
\'Hello\'");
DebuglLogString(s);

Example 2. Show CPU usage on Graph 1 updating on Timer 3.
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var id = "1"; // id of the Charts object
var timer_id = "3"; // id of the Timer object to trigger the script
SLAVE_id = "DESKTOP-5397BVV"; // 1id of the Computer object

if (Event.SourceType == "TIMER" && Event.Action == "TRIGGER" && Event.Sourceld ==
timer_id)
{

var date = Event.GetParam('"date");

var time = Event.GetParam("time");

var cpu = "for /f \"tokens=2* delims=7,\" %k in ('typeperf \"\\Processor
Information(_Total)\\% Processor Time\" -sc 1 A| findstr \":\"') do echo %k";

var cpu_usage = run_cmd(cpu);

var cpu_usage2 = cpu_usage.replace(/\"/g,"");

var cpu_usage3 = cpu_usage2.replace(/\s/g,"");

DebuglLogString(cpu_usage3);

DoReactStr ("ANALOGCHART",1id,"ANALOG_PARAMS" ,"int_obj_id<"+id+">,parent_id<>,SLAVE
_id<"+SLAVE_id+">,objid<"+id+">,chan<5>,core_global<l>,text<"+cpu_usage3+">,
min_val<0>,max_val<1l00>,sensor_id<cpu_usage>,time<"+time+"> ,date<"+date+">");

}

The WritelniAny method

The WritelniAny method is used for writing a string variable to an ini-file. Unlike the Writelni method, in WritelniAny
you can specify the required file section for writing.

Method call syntax:

function WriteIniAny(varName: String, varValue: String, path: String, section:
String)

Method arguments:

1. varName - required argument. Sets the name of the variable for saving in the file.

2. varValue - required argument. Sets the value of a variable.

3. path -required argument. Sets the full path to the ini-file where the variable should be stored. The storage
of variables can be placed on a network resource; for this, specify the network path in this argument.

4. section - required argument. Specifies the name of the section of the ini-file where the variable should be
stored.

Example. Write the MyVar variable to the "config" section of the C:\\Backup\\test2.ini file, and specify the "Hello
world!" value to it. Then read the written value and display it in the debug window of the script.

WriteIniAny("MyVar", "Hello world!", "C:\\Backup\\test2.ini", "config");
var result = ReadIniAny("MyVar","C:\\Backup\\test2.ini", "config");
DebuglLogString(result);
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5.2.2 The MsgObject and Event objects and their built-in methods and properties

The MsgObject and Event objects

MsgObject is a prototype (template) used to create objects with methods and properties for handling events. The
methods and properties of MsgObject allow receiving the information about objects that send or receive events,
generating actions, changing object states, etc.

The methods and properties of the MsgObject prototype can be called via its instance objects or the Event static
object.

Event is a static object used to call events in Axxon PSIM. The Event object represents the system event that
launched the script. All MsgObject methods and properties are available for the Event object.

The CreateMsg method of the Core object is used to create instances based on the MsgObject prototype.

The GetSourceType method
The GetSourceType method returns the type of the MsgObject or Event object.
Method call syntax

function GetSourceType() : String

Method arguments: no arguments.
Usage examples

Problem. When Macro 1 starts, arm Detection Zones *.1 in the Day mode for Cameras Ne 1 - 4. When Macro 2 starts,
arm Detection Zones *.2 in the Night mode for Cameras Ne 1 - 4. When Macro 3 starts, arm Detection Zones *.3in
the Rain mode for Cameras Ne 1 - 4.

() Note

Symbol "*" corresponds to identification number of a camera in the system (from 1 to 4).

if(Event.GetSourceType() == "MACRO" && Event.GetAction() == "RUN")

{

var k;

//Switching the cameras to the Day mode by arming the *.1 detection zones
if(Event.GetSourceId() == "1")

{

for (k = 1; k<= 43 k = k+1)

{

DoReactStr ("CAM_ZONE", k + ".1", "ARM", "");
DoReactStr ("CAM_ZONE", k + ".2", "DISARM", "");
DoReactStr("CAM_ZONE", k + ".3", "DISARM", "");

}

}

//Switching the cameras to the Nigh mode by arming the *.2 detection zones
if(Event.GetSourceId() == "2")

{

for (k = 1; k<= 4; k = k+1)
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{

DoReactStr ("CAM_ZONE", k + ".1", "DISARM", "");
DoReactStr ("CAM_ZONE", k + ".2", "ARM", "");
DoReactStr ("CAM_ZONE", k + ".3", "DISARM", "");
}

}

//Switching the cameras to the Rain mode by arming the *.3 detection zones
if(Event.GetSourceId() == "3")

{

for (k = 1; k<= 4; k = k+1)

{

DoReactStr("CAM_ZONE", k + ".1", "DISARM", "");
DoReactStr("CAM_ZONE", k + ".2", "DISARM", "");
DoReactStr ("CAM_ZONE", k + ".3", "ARM", "");

}

}

}

The GetSourceld method
The GetSourceld method returns the identification number of the MsgObject or Event object.

Method call syntax

function GetSourceId() : String

Method arguments: no arguments.
Usage examples

See the example for the GetSourceType method.

The GetAction method
The GetAction method returns the event received as an Event object or specified for a MsgObject object.

Method call syntax

function GetAction() : String

Method arguments: no arguments
Usage examples

See the example for the GetSourceType method.

The GetParam method
The GetParam method returns the value of the specified parameter of the MsgObject or Event object.

Method call syntax
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function GetParam(param: String) : String

Method arguments:

param - required argument. The name of the parameter of the object created using MsgObject (or of the Event
object). It takes the following values: type - String, range - available parameters for the objects of the specified

type.

() Note

If the object has no parameter with this name, then the method restores an empty string.

Example. When any event from any camera is registered, check from which computer the event comes. If the
computer has “WS3” name, create the event copy where the computer’s name is “Computer”.

if (Event.SourceType == "CAM")

{

var msg = Event.Clone();

if (msg.GetParam("SLAVE_id") == "wS3")
{

msg.SetParam("SLAVE_id", "Computer");
NotifyEvent(msg);

}

}

The SetParam method

The SetParam method assigns a value to the specified parameter of the MsgObject or Event object. It changes only
the specified parameters, leaving other parameters intact.

Method call syntax

function SetParam(param : String, value : String)

Method arguments:

1. param - Required argument. The name of the parameter of the object created using MsgObject (or of the
Event object). It takes the following values: Type - String, range - available parameters for the objects of the
specified type.

2. value - Required argument. The value to be assigned to the parameter specified in the param argument. It
takes the following values: Type - String, range - depends on the parameter.

Usage examples

See the example for the GetParam method.

The MsgToString method
The MsgToString method transforms MsgObject objects (including the static Event object) into a String variable.
Method call syntax
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function MsgToString() : String

Method arguments: no arguments.
Usage examples

Problem. Send the messages about all events registered for Microphone 1, to a specified e-mail address.

() Note

The Short Messages Service is supposed to be installed and working properly.

if (Event.SourceType == "OLXA_LINE" && Event.Sourceld == "1")

{
var msgstr = Event.MsgToString();

DoReactStr ("MAIL_MESSAGE", "1", "SEND", "subject<Microphone 1>,body<" + msgstr + ">")

)

DoReactStr ("MAIL_MESSAGE", "1", "SEND", "");
}

The StringToMsg method

The StringToMsg method transforms a String variable into an MsgObject object.
Method call syntax

StringToMsg(msg : String) : MsgObject

Method arguments:

msg - Required argument. A String type variable to be transformed into an MsgObject object. It takes the following
values: Type - String; range - character string that matches the syntax for MsgObject representation:

"objtypelid|action|paraml<valuel>param2<value2>...", where
objtype - object type;

id - object identification number;

action - event or action for the object;

paramil<valuel>,param2<value2> - list of parameters and their values. Elements of the list are separated by
commas with no white space. If no parameters need to be specified, an empty string is used after the vertical line (|),
for example:

"CAM|1|MD_START|"
Usage examples

Problem. Upon an alarm in Sensor 1 or 3, start recording audio from Microphone 1. Upon an alarm in Sensor 2 or 4,
start recording audio from Microphone 2.

if (Event.SourceType == "GRAY" && Event.Action == "ALARM")
{

var audioid;

if (Event.SourceId == "1" || Event.SourceIld == "3")

Programming in JScript- 43



PSIM 1.0.0-1.0.1 (english) - Programming Guide (JScript)

{

audioid = "1";

}

if (Event.SourceId == "2" || Event.Sourceld == "4")
{

audioid = "2";

}

var str = "OLXA_LINE|"+audioid+"|ARM|";
var msg = CreateMsg();
msg.StringToMsg(str);

NotifyEvent(msg);

The StringToParams method

The StringToParams method transforms a String variable into the list of parameters and overwrites the existing
parameter list of the MsgObject object.

Method call syntax

StringToParams(String params)

Method arguments:

params - Required argument. A String type variable to be transformed into a list of parameters for the MsgObject
object. It takes the following values: String variables matching the syntax for MsgObject parameter list
representation:

“paraml<valuel>param2<value2>...”, where

parami<valuel>,param2<value2> - list of parameters and their values. Elements of the list are separated by
commas with no white space. If no parameters need to be specified, an empty string is used after the vertical line (),
for example:

“CAM|1|MD_START|”
Usage examples

Example. Upon registration the connection (“Attach”) event for any camera, in the system retrigger the “Attach”
event with modified Number of the PTZ device (telemetry_id) and Number of the microphone for synchronous
recoding (audio_id) parameters. The values should be equal to the corresponding camera numbers plus 1.

if (Event.SourceType == "CAM" && Event.Action == "ATTACH")
{
var 1;
for (i=1,i<=4;i=1i+1)
{
var msg = Event.Clone();
var str = "telemetry_id<" + (i+1) +">,audio_id<" + (i+1) + ">";

msg.StringToParams(str);
NotifyEvent(msg) ;

}

}
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The Clone method
The Clone method creates a copy of an MsgObject or Event object.

Method call syntax

Clone() : MsgObject

Method arguments: no arguments.
Usage examples

Problem. When Relay Nel closes, start video recording from Camera 1 and close Relay Ne2. When Relay Nel opens,
start video recording from Camera 2 and open Relay Ne2.

if (Event.SourceType == "GRELE" && Event.Sourceld == "1")
{

var msgevent = Event.Clone();

if(Event.Action == "ON")

{

msgevent.Sourceld = "2";

DoReact(msgevent) ;

DoReactStr ("CAM","1" ,"REC","");

DoReactStr ("GRELE","2","ON","");

}
if(Event.Action == "OFF")
{
msgevent.Sourceld = "2";

DoReact(msgevent) ;
DoReactStr ("CAM","2" ,"REC","");
DoReactStr ("GRELE","2","OFF","");

3
}

The GetObjectlds method

GetObjectlds method is responsible for receiving identifiers from all the objects of a specified type.

Method call syntax:

function GetObjectIds(objectType : String)

Alineisreplied:
CAM||COUNT|id.3<5>,id.count<4>,id.0<2>,id.1<3>,id.2<4>
where id.count<> - number of ID objects,

id.[count]<> - ID object.

Method’s arguments:
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objectType - required argument. Set the type of the system object, for which the value of the given parameter
should be given back ("CAM","GRAY","GRABBER" e.t.c.). Accepted values: type String, range is restricted by object
types registered in the system.

Example. All the cameras should be armed upon the start of MacrosNel.

if (Event.SourceType == "MACRO" && Event.SourceIld && Event.Action == "RUN")
{
var msg = CreateMsg();
msg.StringToMsg(GetObjectIds("CAM"));
var objCount = msg.GetParam("id.count");
var 1i;
for(i = 0; i < objCount; i++)
{
DoReactStr ("CAM", msg.GetParam("id." + 1), "ARM", "");
}
}

The GetObjectParams method
GetObjectParams method is designed for getting the object’s parameters.

Method call syntax:

function GetObjectParams(objectType : String, objectId : String)

Method arguments:

1. objectType - required argument. Set the type of the system object ("CAM", "GRAY", "GRABBER" e.t.c.), for
which the type of a parent object should be given back. Accepted values: type String, range is restricted by
object types registered in the system.

2. objectld - object’s identifier. Accepted values: String type.

Example. It is necessary to check the color control of camera Ne2 upon the start of MacrosNel. If camera 2 is a color
one, set it to recording.

if (Event.SourceType == "MACRO" && Event.Sourceld && Event.Action == "RUN")
{

var msg = CreateMsg();

msg.StringToMsg(GetObjectParams ("CAM", "2"));

if(msg.GetParam("color") == "1")
{

DoReactStr("CAM", "2", "REC", "");
}

}

The SourceType property
The SourceType property stores the system type of the MsgObject or Event object.
Property call syntax
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SourceType : String

Usage examples

Problem. When Relay 1 closes (for example, the button connected to the relay is pressed), print the frames from
Cameras 1and 2.

if (Event.SourceType == "GRELE" && Event.Sourceld == "1" && Event.Action == "ON")
{

//activating the Camera 1 window

DoReactStr ("MONITOR","1","ACTIVATE_CAM", "cam<1>");
//printing the frame from Camera 1

DoReactStr ("MONITOR","1","KEY_PRESSED","key<PRINT>");
//activating the Camera 2 window

DoReactStr ("MONITOR","1","ACTIVATE_CAM", "cam<2>");
//printing the frame from Camera 2

DoReactStr ("MONITOR","1","KEY_PRESSED","key<PRINT>");

The Sourceld property
The SourceType property stores the identification number of the MsgObject or Event object.

Property call syntax

Sourceld : String

Usage examples

See the example for the SourceType property.

The Action property
The Action property stores the action or event of the MsgObject or Event object.

Property call syntax

Sourceld : String

Usage examples

See the example for the SourceType property.

5.3 Creating your first script

As an example of using JScript in Axxon PSIM, try to create a script for the following tasks: when Macro 1 starts, set
the value 10 to the Hot Recording parameter for Cameras No 1 - 4 and output the Hello world message to the
debugger window of the Editor-Debugger utility.

To create and run this script, do the following:
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1. Inthe Hardware tab of the System Settings window, create four Camera objects with identification
numbers 1,2, 3 and 4, if they have not been created before.
2. Inthe Programming tab, create a Macro object with identification number 1. The Events table should not be

filled for.

3. Create a Script object in the Programming tab. Enter the identification number 1 and the name Script 1.

4. Inthe Script 1 object settings panel, select Always in the Time zone list.

5. Click the Editor-Debugger button at the bottom of the Script 1 settings panel. The Editor-Debugger window
will open.

6. In the Editor-Debugger window, open the Script Debug/Edit list and select the Script 2 object.

% Script 2

File View Debugand edit Listof events Help

# EE D F =]

o Script

B Script messages |
B Debug-edit script
- Seript 1
- Secript 2

7. Enter the following in the Script field:

if (Event.SourceType == "MACRO" && Event.Sourceld == "1" &&
Event.Action == "RUN")

{

var ;

for(i=1; i<=4; i=1i+1)

{

SetObjectParam("CAM",i,"hot_rec_time","10");

}

DebuglLogString ("Hello world");

}

8. Inthe File menu, select Save to database to save the script.
9. Create a test event to run the script in debug mode - “MACRO|1|RUN|”. To achieve this, in the Debug and
edit menu, select Edit test event; the Test message window will open. Fill in the fields in the Test message
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window as shown in figure.
@ Script 2
File View Debugandedit Listof events Help

r»EBEBE|2®midFEO|

o |—Scaipt

[ Script messages
=8 Debug-edit script
Script 1

i Seript 2

Test message ot

—SourceType
| MACRO

—Sourceld
| 1
—SourceAction
| RUN

paranm | value |

oK I Cancel

. To run the script with the test event, select Test run in the Debug and edit menu.

. Open the Script Messages list and select Script 1. The debugger window will open at the right side.

. Inthe debugger window, find the “Process Event:MACRO|1|RUN|” line and the following error message: “Src
identifier missing: Microsoft JScript compilation error Line:2 Char:6 Error:0 Scode:800a03f2”.
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a

Description

- Script messages

[

i LSeript2

£ Debug-edit script
+- Script 1
L. Script2

Event EndiSCRIPT]T[INIT|guid_pks< >, begin-end delay: 0 [msec]
Event Start:SCRIPT]1[INITEVENT.objtype.count <0, guid<{A1FDESBA-DE22-ED11-BA2B-80B633F2955C ) > namex Script 1,int_obj_id< 1> parent_id= > type<0>, SLAVE slave_id.count<0> time_zone<>,_marker< » SLAVE.guid.count-
Ervor: Line:2 Char5 Expeeted identifier Src: Microsoft IScript compilation errer Errori0Scodesi0la032 T
Event End:SCRIPT]1[INIT|guid_pk-< >, begin-end delay: 0 [msec]

Event Start:SCRIPT|1[INITEVENT.objtype.count <05, guid<{A1FDBSBA-DE22-ED11-B42B-20BE55FE955C]> ,name< Script 1> ,int_obj_id<1> parent_id<> type<0> SLAVE.slave_id.count<0> time zone<>, marker<> SLAVE.guid.count-
Ervor: Line:2 Chari5 Expected identifier Src: Microsoft IScript compilation error Error0Scode800a00.2
Event EndiSCRIPT]1[INIT|guid_pk<>, begin-end delay: 0 [msec]

Event Start:SCRIPT]1[INI TEVENT.objtype.count 0>, guid <{A1FDESBA-DE22-ED11-BA2B-80B635F8955C) > name Script 15-int_obj_id<1>,parent_id > type<0>, SLAVE slave_id.count<0> time_zone<>,_marker< » SLAVE.guid.count-
Enror: Line:2 Char5 Expected identifier Src: Microsoft IScript compilation errer Error0Scodei00a0302
Event EnciSCRIPT]1[INIT]guid_pk< >, begin-end delay: 0 [msec]

Event Start:MACRO|1[RUN] <>

Ervor: Line:2 Char5 Expected identifier Sre: Microsoft IScript compilztion errer Errori0ScodesiOta032
Event Enc:MACRO[1|RUN|guid_pk<>, begin-end delay: 0 [msec]

Unable to CoC CLSID_ProcessD

Event Start:MACRO]1[RUN| <>

Enror: Line:2 Char5 Expected identfier Src: Microsoft IScript compilation errer Error0Scodes00a0302
Event EnckMACRO|1|RUN|guid_pk< >, begin-end delay: 0 [msec]

Unable to CoC e CLSID_ProcessD!

Event Start:MACRO|1RUN <>

Emor: Line:2 Char5 Expected identifier Sre: Microsoft fScript compilation error Error SeodesiOtal3f?

Event EnckMACRO)|1|RUN|guid_pk< >, begin-end delay: 0 [msec]

Event Start:MACRO]1[RUN] <>
Ervor: Line:2 Char5 Expected identifiet Src: Microsoft JScript compilation error ErrerScodef00a03f2
Event EniMACRO|1|RUN|guid_pk< >, begin-end delay: 0 [msec]

Event Start:MACRO|1[RUN| <>

Error, Line:2 Char Expected identifier Sre: Microoft IScript compilation error Errori0 Scodesi0ta03f2
Event End:MACRO|1|RUNIguid_pk< >, begin-end delay: 0 [msec]

Event Start:MACRO[1[RUN <>

Exvor: Line:2 Char5 Expected identifier Src: Microsoft IScript compilation eror Errorl SeodeO0al32
Event EndiMACRO|1|RUNIguid_pk<>, begin-end delay: 0 [msec]

Unable to CoC CLSID_ProcessD

Event Start:MACRO|1[RUN| <

Enror: Line:2 Char5 Expected identifier Src: Microsoft IScript compilation errer Error0Scodes00a0302
Event EnckMACRO|1|RUN|guid_pk+< >, begin-end delay: 0 [msec]

Unable to CoCl CLSID_ProcessD

Event Start:MACRO[1RUN| <>

Event End:MACRO[1[RUN|guid_pk< >, begin-end delay: 0 [msec]
< >
[cap [num [scRL

=] Seript 1 - o x
File View Debugand edit Listof events Help
HEE=|cei%$FHE

~

v

A

The error message says that there is no identifier in the second line of variable declaration operator (var).
That means no variable has been declared. This is a critical error in JScript, thus the script has not been

executed.

Change the text of the script (see the “vari;” line).

if (Event.SourceType == "MACRO" && Event.Sourceld &&
Event.Action == "RUN")

{

var 1i;

for(i=1; i<=4; i=1i+1)

{

SetObjectParam("CAM",i,"hot_rec_time","10");

}

DebuglLogString ("Hello world");

}

In the File menu, select Save to database to save the script.

Repeat steps 10 and 11.

In the debugger window, find the “Process Event:MACRO|1|RUN|” line and the “DebuglLogString:Hello world”
and “Script first run OK” messages. The “Script first run OK” means that the script runs correctly in the

Programming in JScript- 50




17.
18.

19.
20.

PSIM 1.0.0-1.0.1 (english) - Programming Guide (JScript)

debug mode.

% Script 2

File View Debugandedit Listof events Help

XT3 S 400

2 | Description

E| Debug-edit script

= Script messages Script first run OK

Event End:5CRIPT|2|INIT|guid_pk<>, begin-end delay: 0 [msec]
Event Start: MACRO[1|RUN|

DebuglogString-[5cript:2], (0492):Hello world

Script first run OK

Event End:MACRO|1|RUM|guid_pk«<>, begin-end delay: 0 [msec]
Event Start:|||

Script first run OK

Event End:|||guid_pk= =, begin-end delay: 0 [msec]

Event Start: MACRO[1|RUN|

DebuglegString-[Script:2], (3564):Hello world

3| | Script first run OK

Input-Cutput
MACRO[1|RUN|

M| 4] | w| Y, Script messages 5 Trial event

Close

the Editor-Debugger utility.

The text of the created script will be shown in the Script field of the Script 1 object settings panel. Click the
Apply button in the Script 1 settings panel to activate the script.

Select Macro 1 in the Run menu of the main control panel.

In the debugger window of the Axxon PSIM system, check that the macro and the script have run
successfully.

B Debug window

Clear Colors Filter [ apply filter [ use regex Search

Event:
React :
Event:
Event :
React :
React :
Event

CORE||DO_REACT |slave_id <W51=>,fraction <225 ,owner <W51>,module <video.run:,action <RECORD_STOP>,date<24-08-22> param5_val <C: \WWIDEC \writing.w03> ,param4_val<24-08-22 17:12:24.1!
OLXA_LINE|2|RECORD_STOP [src<Ct \WWIDEOQ Ywriting. w02, time_start<24-08-22 17:12:23,276>, time_end <24-08-22 17:12: 25,476 > ,cam < 2> ,dst<C:\WIDEOQ\24-08-22 1712C. w02 ,sending_time <24-08-
CORE||DO_REACT |slave_id<W5 1>, fraction <475 > ,0wner <W5S1> module <video.run> action <RECORD_STOP > date<24-08-22> param5_val <C: \WIDEQ \writing. w02 param4_val<24-08-22 17:12:23.2]

+ SLAVE|WS 1|PING |slave_id<WS 1>, owner <W5 1> module <video.run > date <24-08-22 >, ver_type<0> guid_pk<{3ED566D4-6623-ED 11-B42C-80B655F8955C) =, core_global<1> tme<17:12:54>

SCRIPT|2|SETUP|parent_id< > type <0 objname <Script 2= EVENT. action. count<0>,_marker < > flags< > EVENT.guid.count<0> SLAVE.guid.count<0 > EVENT. objtype.count <0 > script<if (Event. Source
SCRIPT|2|SETUR |parent_id< =, type <0:,objname <Script 2= EVENT. action. count<0:>,_marker < ,flags< = EVENT. guid.count=0>,SLAVE. guid. count <0 > EVENT. objtype. count <0 = script<if (Event.Source

: CORE||UPDATE _OBJECT |time_zone < >, objid<2:» SLAVE. guid.count<0 > flags <> objname <Script 2> parent_id< > guid< {478 16 26F-B023-E011-842C-80B55F8955C; = script<if (Event.SourceType =="

[React :

SCRIPT|2|SETUR [parent_id< >, type <0 objname <Script 2= EVENT. action. count<03,_marker <=, flags< > EVENT. guid.count<0: SLAVE. quid. count <0 = EVENT. objtype.count <0 >, script<if (Event. Sourc]

React :

CAM| 115_EI'UP |AUDIO. mic_slave.0<WS1> bosch_ptz_protocol< > audio_type <OLXA_LINE >, yuv <0 stream_dient< > arch_days_type <0:,priority <0>,md_mode <0 compressor < > activity <>,armed <

Programming in JScript- 51



PSIM 1.0.0-1.0.1 (english) - Programming Guide (JScript)

21. Check the accuracy of the script result. The Hot recording field in the Camera 1 to Camera 4 object settings
panels should read “10”.

0 Caphure « . izable

Yideo capture device 1

-

mna

Recording audio
Mumber  Microphone

RN Standard

i

Recording frame rate - fps

(@ Note

The Hot recording field in the Camera settings panel is empty by default.

Script creation and debugging is now complete.
5.4 Script debugging

5.4.1 Script debugging features

The Editor-Debugger utility allows debugging scripts using the built-in tools for checking script syntax, script
interpreting and script execution with test events generated by the utility. The messages about the debugging
results are displayed in the corresponding debugger windows.

The Editor-Debugger utility provides the following debugging functionality:

1. Aseparate debugger window is assigned to each Script object, where the test and system events, error
messages, success messages and user information messages are displayed. The messages in the debugger
windows can be filtered.

2. Special Information window debugger windows are available for displaying the messages related to the
script being debugged.

3. Testevents generated by the Editor-Debugger utility, which are not registered by the Axxon PSIM system, are
used for checking script accuracy.

4. Third-party debugger programs can be used for step-by-step execution, viewing script variables during
execution, and other functionality.
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The Editor-Debugger utility is capable of generating test events chosen by the user to help debug the scripts. Test
events are not registered by the video surveillance system, i. e. they are not listed in the events log and not saved to

the database.

No more than one test event can be created for each script.

To create a test event, do the following:

1. Inthe Debug and edit menu, select Edit test event, or click the

2. The Test message window will open.

button in the toolbar.

File View Debugandedit List of events Help
»EIHDE b [] [
o Script

- Script messages
- Debug-edit script
L Seript 1

L. Seript 2

Test message

SourceType -

|MACRO

Sourceld

| 1

SourceAction

| RUN

param

| value

oK | Cancel

This window is used for entering the test event parameters.
3. Enter the following information in the fields of the Test message window:

a. SourceType - object type;
b. Sourceld - object identification number;

c. SourceAction - the event generated by the specified object;

d. param - additional event parameters;

e. value - values of the additional parameters.

4. Click the OK button.
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The test event is now created.

The created test event will be displayed in the Event field in a special string format.

& Script 2 - O X
File View Debugandedit Listof events Help
@ ELED S [+ [-]
i § Seript
El- Script messages if (Event.SorceType == "MACRC" &£& Event.Sourceld &£& Event.Action == "RUN")
L. Script 1 =1
Script 2 i N, e
E--Debug-editscript for (i=1:; i <4; i=i+l)
i Script 1 !
= SetObjectParam ("CaM",i,"hot rec time","10"});
. Seript 2 e e
DebuglogString ("Hello world™);
£ >
Input-Cutput o x
MACRO[1|RUN|
| 4| »| w|* Script messages j Trial event
Ready CAP |NUM [SCRL

Running the script with a test event

To run the script with a test event, do one of the following:

1. Clickthe Test run ( d: ) button in the toolbar.
2. Inthe Debug and edit menu, select Test run.
3. Inthe Debug and edit menu, select Test run in third-party debugger.

When the Test run in third-party debugger option is selected, the third-party debugger starts to run the test (see
details in the Using third-party debuggers section).

The results of the verification and execution of the script are displayed in the corresponding debugger window of
the Editor-Debugger utility.

5.4.3 Using debugger windows of the Editor-Debugger utility

Displaying messages about starting, verifying, changing and executing scripts in the debugger
windows

The messages in the debugger window track the stages of starting, verification and execution of scripts.

When the event occurs that triggers the script, the following message is displayed in the debugger window:
“Process Event: <script triggering event>"; for example, if the script starts upon Macro 1 execution, the line reads
“Process Event:MACRO|1|RUN|”.
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At the moment of changing the script in Debugger utility or in the Axxon PSIM, the debugger window displays the
message «Process Event: SCRIPT|script’s number|SETUP|» (for example, while changing the script with number 1,
the debugger window displays «Process Event: SCRIPT|1|SETUP|»).

Script syntax is checked before execution. In case of syntax errors, related error messages will be displayed in the
debugger window. Figure shows an example of a syntax error message.

&) Script 3 - m] ®
File View Debugandedit Listofevents Help
AT

2 | Description

2 Seript messages Event StartSCRIPT]3|INITIEVENT.objtype.count <0, just_created<1>,guid<{39DBBE46-F722-ED11-B42B-80B655F8935C}> .name -« Script 3= int_obj_id<3> parent_id< > type<0> SLAVE slave_id.count<0> time_zone<>,_marker<>,SLAY
f L. Script1 Seript first run OK.

£ L. Script2 Event End:SCRIPT|3|INIT|guid_pk<>, begin-end delay: 0 [msec]

- Script 3 Event Start:SCRIPT]3|INITIEVENT.objtype.count <0, guid <{39DBB846-F722-ED11-B42B-80B635F8935C >, name< Script 3> int_obj_id<3> parent_id<> type<0> SLAVE slave_id.count<0> time_zone<>,_marker<> SLAVE.guid.count<0> |

£ Debug-edit script
L. Seript 1
| Script2
*-Script 3 Event End:SCRIPT|3|INIT|quid_pk<>, begin-end delay: 0 [msec]

Event Start:SCRIPT]3|INITIEVENT.objtype.count<0>,guid <{39DBB246-F722-ED11-B42B-80B655F8955C }>,name< Script 3> int_obj_id< 3> parent_id<> type<0> SLAVE slave_id.count<0> time_zone<>,_marker<>, SLAVE guid.count<0>,|

Error: Lined) Char0 Object expected Src: Microsoft [Sciipt runtime enor Enror0 Seodes0021380

Event End:SCRIPT)3|INIT|quid_pk<>, begin-end delay: 0 [msec]
Event Start:SCRIPTI3|INITIEVENT.objtype.count <0>, quid <{39DBBA46-F722-ED1 1-B42B-B0BE35FE935C}>, name < Script 3 int_obj_id< 3> parent_jd<> type<0>,SLAVE slave_id.count<0> time_zone<>,_marker<>, SLAVE.guid.count<0>,|

Event Enc:SCRIPTI3|INIT|guid_pke<>, begin-end delay: O [msec]

Ready CAP |NUM [scRL

Right-click the message to view its complete text. The Information window will open containing the full text of the
error message.

B ' Information X

Error: Line:0 Char:0 Object expected Src: Microsoft 1Script runtime
error Errar:0 Smde:ﬁﬂﬂaﬁaﬂ

The message contains the following information:

Error description;

Error type (for example, Src: Microsoft Jscript compilation error);

Error location in the script text (line number and character number in the line);
Error code (Scode).

Ll N S
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In case no errors were detected, the following message will be displayed in the debugger window: Script first run
OK. Then, the script will run.

Script runtime errors are also displayed in the debugger window.

In case of successful execution of the script, the following message will be displayed: “End ProcessScript, begin-end
delay: <script execution time>; for example, “End ProcessScript, begin-end delay: 13 [msec]”.

Viewing the script messages

Debugger windows display messages about system and test events, errors and successful script execution, as well
as user information messages.

A separate debugger window is assigned to each script in the Editor-Debugger utility.
There are two types of debugger windows: All script messages and Last run script messages.

The debugger windows of All script messages type are listed in the Script Messages list. The names of the
windows match the names of the corresponding Script objects. These windows display all system messages related
to the corresponding script. The example of the debugger window of All script messages type:

3 Script 1 - O x
File View Debugandedit Listof events Help

2 V&

| Description "
B Script messages Event End:-1[1|INIT|guid_pk<>, begin-end delay: 0 [msec]
Event Start:SCRIPT]|INITIEVEMT.objtype.count< 0>, guid<{60AFBA48-T7E23-ED11-B42B-808

Secript first run OK

Event End:-1|1|INIT|guid_pk+<>, begin-end delay: 0 [msec]

Event Stark:SCRIPT|1|INITIEVEMNT.objtype.count< 0=, guid <{G0AFBA48-TE23-ED11-B42B-80B
Script first run OK

Event End:-1|1|INIT|guid_pk<=, begin-end delay: 0 [msec]

Event Start:SCRIPT1|INITIEVEMNT.objtype.count< 0> guid<{B0AFBA4B-TE23-ED11-B42B-20B
Script first run OK

Event End:-1[1|INIT|guid_pk<=>, begin-end delay: 0 [msec]

Event Start:SCRIPT)1|INITIEVENT.cbjtype.count< 0=, guid <{G0AFBA48-TE23-ED11-B42B-80B
Script first run OK

E| Debug-edit script
L Seript 1

< >
Input-Cutput o X
Unable to CoCreatelnstance CLSID_ProcessDebugManager

Event Start:|||

Script first run OK
Event End:0|||guid_pk=< =, begin-end delay: 0 [mseq]
Unable to CoCreatelnstance CLSID_ProcessDebugManager

| 4] »| w| % Script messages 4 Trial event

CAP |NUM |SCRL

In addition, the information on the last script run is displayed on the Script messages tab at the bottom of
the Editor-Debugger utility window. If this panel is not displayed, select Debug and edit > Summary

Information, or click the button on the toolbar.
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&7 Script 1 - O >
File View Debugandedit Listof events Help
# ELE D E -]
i1 | Script
--Script messages FtAction Sourceld SourceType GetSourceTyps GetSourceId Gs
é--Debug—editscript if (Ewvent.SourceType = "GRELE" &£& Event.Sourceld == "1")
W S cript 1 =1
wvar msgevent = Event.Clonel():
if (Event.Action == "CN")
= {
msgevent. Sourceld = "2";
DoReact (msgewvent);
msgevent . Soarceld = "3";
DoReact (msgewvent):
L4 >
Input-Cutput o x
Unable to CoCreatelnstance CLSID_ProcessDebughManager
Event Start:|||
Seript first run OK
Event End:0|||guid_pk=< =, begin-end delay: 0 [mseq]
Unable to CoCreatelnstance CLSID_ProcessDebugManager
1| 4] #| M| Script messages /4 Trial event /
Ready CAP |NUM |SCRL

Both types of debugging windows are used in the same way.

5.4.4 Using third-party debugger programs

The Axxon PSIM software package officially supports debugger Microsoft Visual Studio 2005.

The Axxon PSIM software package allows using third-party debuggers for processing JScript scripts. These programs
may have the functionality that is not included in the Editor-Debugger utility, for example, step-by-step script

execution, watching script variables during script execution, etc.

() Note

We do not recommend using third-party debuggers, since they do not provide full compatibility with the
Axxon PSIM software, and may lead to failure of the Axxon PSIM software.

We strongly recommend introducing the breakpoint in the script when using third-party debuggers. To insert the
breakpoint, add the following line to the script: “debugger;”. The script execution will pause at this line, and the

debugger will start.

When a third-party debugger is used, scripts can be started with test events only.

To start the script using a third-party debugger, do the following:

1. Create the script and insert the “debugger;” line in it.
2. Create a test event for the script.

3. Inthe Debug and edit menu, select Test run in third-party debugger.
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4. The Just-In-Time Debugging window will open. Select one of the debuggers installed on the computer.
Just-In-Time Debugging

Please select a debugger.

— Possible Debuggers:

Mew instance of Microsoft Scripk Editor

[~ Set the currently selected debugger as the default,

Do you want to debug using the selected debugger?

Yes Mo I

5. Click Yes to confirm the selection.

In case of a successful syntax check (no errors found before the “debugger;” line), the third-party debugger will
start. The script will pause at the breakpoint.

Example. A script with the use of the breakpoint when Macro 1 starts.

if (Event.SourceType== "MACRO" && Event.SourceId=="1" && Event.Action == "RUN"); //
start Macro 1

{

debugger; // breakpoint

DebuglLogString ("Hello world");

}

5.5 Examples of scriptsin JScript language

On the page:

« Example 1. Visualisation
of operating the Queue
length detection in the
Video Surveillance
monitor

« Example 2. Visualisation
of operating the People
Counter detection in the
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Video Surveillance
monitor

« Example 3. Setting the
text for displaying on
the map

« Example 4. Displaying
camera on the monitor
by clicking the button
on the remote control

« Example 5. Sending
command to camera
using the camera
HTTPAPI

« Example 6. Script for
framing abandoned
objects in live video

« Example 7. Using START
and STOP events for the
Failover Service

« Example 8. Using the
embedded visitors
counter on Bosch
FLEXIDOME IP dynamic
7000 VR IP camera

« Example 9. Sending e-
mail with HTML markup

« Example 10. Creating
test users

« Example 11. Changing
the status of the event
in the Incident manager

To illustrate available fields of application of scripts in JScript see the following examples which can be used to
create additional functions in the system on the basis of the Script object.

5.5.1 Example 1. Visualisation of operating the Queue length detection in the Video
Surveillance monitor

The Queue length detection object (part of the DetectorPack package), Camera and Captioner objects (instead of
N, M, L symbols set the corresponding numbers of the Queue length detection, Camera and Captioner objects) are
to be created and configured for correct script working in the Axxon PSIM software.

//Event reading by the queue length
if (Event.SourceType == "OCCUPANCY_COUNTER" && Event.SourceId == "N" && Event.Action
== "OCCUPANCY") //N - Number of Queue length detection
{

var n=Event.GetParam("occupancy");
//Displaying the queue number by the Captioner in the Monitor

DoReactStr ("CAM","M" ,"CLEAR_SUBTITLES","title_id<L>"); //M - Number of Camera L -
Number of Captioner
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DoReactStr ("CAM","M" ,"ADD_SUBTITLES","command<Queue length: "+n+" person(s).
\r>,page<BEGIN>,title_id<L>"); //M, L - the same
}

As a result the text message about the current queue length will be imposed on the video image while displaying
the corresponding camera in the Video Surveillance monitor.

Settings of the font, color and position of text is configured on the settings panel of the Captioner object.

(@ Note

When page<BEGIN> and page<END> parameters are in use, the corresponding fields of the subtitles
database are filled in. This enables data search using the Search by titles interface object.

5.5.2 Example 2. Visualisation of operating the People Counter detection in the
Video Surveillance monitor

The People Counter Detection object (part of the DetectorPack package), Camera, Captioner and Macro objects
(instead of N, M, L, P symbols set the corresponding numbers of the People counter detection, Camera, Captioner
and Macro objects) are to be created and configured for correct script working in Axxon PSIM.

//Event reading and counting of entered people
if (Event.SourceType == "PEOPLE_COUNTER" && Event.SourceId == "N" && Event.Action ==
"IN") //N - Number of People Counter detection
{
i Itv_var("counter_i");
k = Itv_var("counter_k");
i+

Itv_var("counter_i")=1;
//Displaying the number of people by Captioner in the Monitor

DoReactStr ("CAM","M" ,"CLEAR_SUBTITLES","title_id<L>"); //M - Number of Camera L
- Number of Captioner

DoReactStr ("CAM","M" ,"ADD_SUBTITLES","command<Number of people (entering/
exiting): "+i+" / "+k+"\r>,page<BEGIN>,title_id<L>"); //M, L - the same

}
//Event reading and counting of exitng people
if (Event.SourceType == "PEOPLE_COUNTER" && Event.SourceId == "N" && Event.Action ==
"OUT") //N - Number of People Counter detection
{
i = Itv_var("counter_i");
k Itv_var("counter_k");
k++3
Itv_var("counter_k")=k;
//Displaying the number of people by Captioner in the Monitor

DoReactStr ("CAM","M" /"CLEAR_SUBTITLES","title_id<L>"); //M - Number of Camera L -
Number of Captioner

DoReactStr ("CAM","M","ADD_SUBTITLES","command<Number of people (entering/exiting):
"+i+" / "+k+"\r>,page<BEGIN>,title_id<L>"); //M, L - the same

}
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//Null the counter by Macro (previously the Macro is to be created in the Axxon PSIM)
if (Event.SourceType == "MACRO" && Event.Sourceld == "P" && Event.Action == "RUN") //
P - Number of Macro
{

Itv_var("counter_i")=0;

Itv_var("counter_k")=0;

i=0;

k=0};
//Displaying number of people by Captioner in the Monitor

DoReactStr ("CAM","M" ,"CLEAR_SUBTITLES","title_id<L>"); //M - Number of Camera L
- Number of Captioner
DoReactStr ("CAM","M" ,"ADD_SUBTITLES","command<Number of people (entering/
exiting): "+i+" / "+k+"\r>,page<BEGIN>,title_id<L>"); //M, L - the same
}

As a result the text message about number of entering and exiting people will be imposed on the video image while
displaying the corresponding camera in the Video Surveillance monitor.

(@ Note

When page<BEGIN> and page<END> parameters are in use, the corresponding fields of the subtitles
database are filled in. This enables data search using the Search by titles interface object.

Settings of the font, color and position of text is configured on the settings panel of the Captioner object (see
Configuring captions display on a video image).

Previously create the Macro object on the Programming tab to null the counter of visitors. The name of the object
can be changed to “Null of people counter” for ease of using.

Macro of setting to zero can be run manually by main menu of Axxon PSIM or automatically in any specified time
(use the Events table on the settings panel of the Macro object where the previously configured Time zone object
is to be specified). Detailed information about using the Macro and Time zone objects is given in the
Administrator’s Guide document).

5.5.3 Example 3. Setting the text for displaying on the map

It is possible to select the type of Text displaying while attaching object to the map (see Attaching objects to the
layers of interactive map). Also the script on the JScript language can be used for changing the displayed text.

Example. The Text type of display on the map is selected for the Camera 1. It's required to display value of the
MyVar value read from the C:\test.ini file on the map and debug window while processing the Macro 1.

if(Event.SourceType == "MACRO" && Event.Action == "RUN")

{

var result = parseInt(ReadIni("MyVar","C:\\test.ini"));

result += 2;

NotifyEventStr ("CAM","1" ,"ANALOG_PARAMS","text<Variable value = \n" + result + ">,
blink_state<1>");

DebuglogString(result);

1
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5.5.4 Example 4. Displaying camera on the monitor by clicking the button on
the remote control

The following example is valid only for cameras in configuration of which there is PTZ control panel. When
configuring Video surveillance monitor select the Go to preset action with 1,2,3...,0 parameters for ten joystick
buttons (see Assigning commands to joystick buttons using the Monitor section of Installing and configuring
security system components guide).

Mause oystick
Behavior Action Param. Butt., Action

Left (Defaul) "B

Right button {Default) = - e Go to preset
= Go to t

Middle button (Default) L - bl T

=l
[T
"]
o
=

Go to preset

Scraolling ({Default) = - o to preset
shift 4+ Scrolling (Default) = - M Go to preset
Shift + Left (Default) v - Gy B ek
: - Go to preset
Shift + Right (Default) v - R
shift +Middle butt. e o v|  BS0R Go to preset
az i % {=]

List of cameras | PTZ it =

Undo

Example. When the button is clicked on the control panel, display corresponding camera in the active monitor. The
script is to timer trigger with ID=1.

() Note

The Timer object is to be created and configured beforehand and the current year is to be set. Information
on how to configure the Timer object can be found in Creating and configuring the Timer object.

After each button click on the control panel wait for 2 seconds until clicking another button. If there is no button
click, then the camera with dialed number is to be displayed.

if (Event.SourceType=="TIMER" && Event.SourceId=="1" && Event.Action=="TRIGGER")
{

mon="1";

DebuglLogString("on monitor "+ Itv_var("cam"));

DoReactStr ("MONITOR" ,mon,"ACTIVATE_CAM","cam<"+Itv_var("cam")+">");
Itv_var("cam")="";

}
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if (Event.GetParam("source_type")=="TELEMETRY" && Event.GetParam("action")=="GO_PRESE
™)
{

DoReactStr ("TIMER","1","START","bound<2>");

var key=Event.GetParam("param4_val");

DebuglLogString("Key:"+key) ;

Itv_var("cam")=Itv_var("cam")+key;

DebuglogString(Itv_var("cam"));

5.5.5 Example 5. Sending command to camera using the camera HTTPAPI
Example. Camera IP address is 192.168.0.13.

The command enables the camera wiper:
192.168.10.101/httpapi/SendPTZ?action=sendptz&PTZ_PRESETSET=85

The command disables the camera wiper:
192.168.10.101/httpapi/SendPTZ?action=sendptz&PTZ_PRESETSET=86

These commands are to be sent to camera using the JScript script.

function DoPreset(preset)

{

xmlhttp=new ActiveXObject("MSXML2.XMLHTTP");

if(xmlhttp == null)

{

return;

}

xmlhttp.open("GET", "http://192.168.0.13/httpapi/SendPTZ?
action=sendptz&PTZ_PRESETSET="+preset, false,"admin","1234");

xmlhttp.send();
DebuglogString(xmlhttp.status);

}
if (Event.SourceType == "MACRO" && Event.Sourceld == "6" && Event.Action == "RUN")
{
DoPreset("85");
}
if (Event.SourceType == "MACRO" && Event.Sourceld == "7" && Event.Action == "RUN")
{
DoPreset("86");
}

5.5.6 Example 6. Script for framing abandoned objects in live video

If the object tracking function is in use (see Creating and configuring the Timer object), then detected objects will be
framed in video when viewing the archive. To frame abandoned objects in live video use the script aimed to frame
an abandoned object when receiving alarm from VMDA detection tool:
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if (Event.SourceType=="CAM_VMDA_DETECTOR")

{
cam=GetObjectParentId("CAM_VMDA_DETECTOR",Event.SourceId,"CAM");
if (Event.Action=="ALARM")

{

var x1,x2,yl,y2;

x1=Event.GetParam("x");

x2=Event.GetParam("w") ;

yl=Event.GetParam("y");

y2=Event.GetParam("h");

x2=parseInt(xl)+parseInt(x2);

y2=parselnt(yl)+parselnt(y2);

DoReactStr ("MONITOR","" ,"SET_MARKRECT","cam<"+cam+">,color<255>,id<"+cam+"> /x1<"+x1+"
> ,X2<"+X2+"> ,yl<"+yl+"> ,y2<l|+y2+ll>ll) ;

DebuglogString ("x1:"+x1+" x2:"+x2+" yl:"+yl+" y2:"+y2);

}

else

{

DoReactStr ("MONITOR","" , "DEL_MARKRECT","cam<"+cam+">,id<"+cam+">");

}
}

5.5.7 Example 7. Using START and STOP events for the Failover Service

Objects from more than one main Server are not to be moved to the Backup Server. For this when moving objects
from some main Server to the Backup Server all other Failover objects are to be disabled on this Backup Server.

if (Event.SourceType == "FAILOVER" )

{

if (Event.Action == "START") {action="DISABLE";}
if (Event.Action == "STOP") {action="ENABLE";}

id=Event.Sourceld;

msg=CreateMsg();
msg.StringToMsg(GetObjectIds ("FAILOVER"));
var

objCount=msg.GetParam("id.count");

for (i=0;1i<objCount;i++)

{

pid=msg.GetParam("id."+1);

if (! (id==pid)) {

DoReactStr ("FAILOVER",pid,action,"");
}

}
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5.5.8 Example 8. Using the embedded visitors counter on Bosch FLEXIDOME IP
dynamic 7000 VR IP camera

Upon reaching the number of visitors equal to 20 on the embedded visitors counter of the Bosch FLEXIDOME IP
dynamic 7000 VR IP camera (with ID 1), call the macro 1.

n=20;

if(Event.SourceType == "CAM_IP_DETECTOR" && Event.SourceId=="1" && Event.Action ==
"DETECTED")

{

v=Event.GetParam("param@").split(";")[1];
if (parseInt(v.split(":")[1])==n)

{

DoReactStr ("MACRO","1","RUN","");

}
}

5.5.9 Example 9. Sending e-mail with HTML markup

By macro 1, send a message with the attached files detected.png and found.jpg from the folder C:\\Pictures\\ to
example@gmail.com. The message should be formatted as follows:

Face detected
Detected face Facein DB
detected.png file found.jpg file
if(Event.SourceType == "MACRO" && Event.SourceId=="1" &&Event.Action=="RUN")
{

var filel = "detected.png";
var file2 = "found.jpg";
var file_folder = "C:\\Pictures\\";

var test_event = CreateMsg();
test_event.StringToMsg("MAIL_MESSAGE | 1|SEND_RAW|
cc<>,to<daniel@AxxonSoft.com>,objname<Mail message
1>,subject<>,parent_id<1l>,flags<>,pack<>,name<Mail message
1>, from<example@gmail.com>,_marker<>");

test_event.SetParam("body","<html><body>\r\n<h3>Face found</
h3>\r\n<table><tr>\r\n<td>Detected</td><td>Found 1in DB</td>\r\n</tr><tr>\r\n<td><img
width='200"' alt="'imagel' src='cid:"

+

filel

+

"r/></td>\r\n<td><img width='200"' alt='dimage2' src='cid:"

+

file2
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"
"r/></td>\r\n</tr><tr>\r\n<td>E-mail sent from Axxon PSIM</td>\r\n</tr></table>\r\n</
body></html>");

test_event.SetParam("attachments",file_folder+filel+";" + file_folder+file2);
test_event.SetParam("is_body_html", 1);

DoReact(test_event);

}

5.5.10 Example 10. Creating test users

Using macro 101, create 50 users in Axxon PSIM with IDs from 100 to 150, assigning them an access level with ID 1
(provided that the AL is assigned to the department to which the users are added and users inherit the department
AL) and linking an access card with a number, equal to the user ID. The card number must be in HEX format. The
department should have no more than 30 users (to speed up the adding process).

() Note

For more information on access levels and access cards, see the ACFA PSIM documentation in the
AxxonSoft documentation repository.

If an ACS integration is configured in Axxon PSIM, which supports dynamic user recording, then the created
user will be automatically written to the ACS controller when the CORE||UPDATE_OBJECT]|
objtype<PERSON=> event is sent. If dynamics is not supported, then recording users to the controller will
need to be initiated manually.

dep=10; // department ID

start=100;// first user ID

last=150; // last user ID

acc_lev=l; // access level ID

dep_count=30; // max number of users in the department

if( Event.SourceType == "MACRO" && Event.Action == "RUN" && Event.SourcelId=="101")
{
kol=0;
card_count=0;
NotifyEventStr ("CORE","","UPDATE_OBJECT","objtype<DEPARTMENT>,objid<"+dep+">");
for (i=start;i<=last;i++)
{
kol++;
card_count++;
card=decToHex (card_count);
if (card[card.length-1]==0)
{
card_count++;
card=decToHex (card_count);

}

if (kol==dep_count)
{
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NotifyEventStr ("CORE","","UPDATE_OBJECT", "objtype<PERSON>,objid<"+i+">,n
ame<user"+i+"> parent_id<"+dep+">, level_id<"+acc_lev+">, facility_code<o>,
card<"+card+">");

kol=0;
dep++;
NotifyEventStr ("CORE","","UPDATE_OBJECT","objtype<DEPARTMENT>,0objid<"+dep
+Il>ll);
}
else
{

NotifyEventStr ("CORE","","UPDATE_OBJECT", "objtype<PERSON>,objid<"+i+"> n
ame<user"+i+"> parent_id<"+dep+">,level_id<"+acc_lev+">,
facility_code<0>,card<"+card+">");

}
Sleep(10);

}
}

function decToHex(n)

{
return Number(n).toString(16);

}

5.5.11 Example 11. Changing the status of the event in the Incident manager

When working with objects in the Incident manager, it is possible to change the event status of an object (see
Processing events). To change the event status of an object, you can use a JScript script.

Example. On macro 3, change the status of the camera 1 or 2 Alarm event to Completed.

if (Event.SourceType == "MACRO" && Event.Sourceld == 3 && Event.Action == "RUN")
{
DoReactStr ("INC_SERVER","1","UPDATE_STATUS","status<3>,objtypes<CAM>,objids<1|
2>,actions<MD_START | MD_START>");

}s

5.6 Operations with scripts

5.6.1 Creating a script

On the page:

+ Creating the Script
object
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+ Creating and editing
a script
« Features
when working
with a script
+ Debugging a script

To create and run scripts in JScript, create the Script system object. Then, in the Editor-Debugger utility, enter the
script, check it and debug it.

You can create JScript scripts in Axxon PSIM using the built-in Editor-Debugger utility.

To start the Editor-Debugger utility, click the Editor-Debugger button in the settings panel of the Script system
object.

Creating the Script object
To create the Script object in Axxon PSIM, do the following:

1. Inthe Programming tab (1) of the System settings dialog window, create the Script object (2).
2. Enterthe identification number and the name for the Script object (3).
3. Click the Apply button (4).

Architecture Hardware efaces Programming 1

Mumnber

= 5 BEE 2

£ Script 1[1]

4

.-'-'q:l P f‘,‘ un do

The Script object settings panel will open.
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Run of zpecified conmputers

Computker Mame

M Disable [ DESKTOP-7332GG3  LOCALHOST

Time zchedule 1 £

|/ *Action SourcseId ScourceTypes GetSourceTyvpe GetSourceld GetAction GetE

| <
Editar - Debugger 3

To configure the Script object, set the values of the following parameters:

1. Inthe Time schedule field (1), specify the time schedule of the script execution: Always, Never or one of the
schedules created earlier (1, see Creating and configuring Time schedules). The default value is Never.
2. Inthe Computers field (2), select the computers (kernels) where the script should run.

(@ Note

By default, the script will run on all computers (kernels). The list displays only the computers
registered in the Hardware tab of the System settings dialog window.

3. Click the Apply button.

Creating and editing a script
To create a script in JScript in Axxon PSIM, do the following:

1. Click the Editor-Debugger button (3) at the bottom of the Script system object panel to open the Editor-
Debugger utility.

() Note

Use the Editor-Debugger utility to create, edit and save scripts in JScript. The settings panel of the
Script system object displays the text of the saved script that can also be edited.
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In the Editor-Debugger utility window, open the Debug-edit script list and select the Script object you want
to edit (for example, the Script 1 object, as in the figure below).

gl, Script 1

File View Debug and edit List of events Help

»EBER= 2

& ¥ P EE

— a X

o

H- Script messages

= Debug-edit script

— Sorint

|/*Action ScurcelId ScurceType GetSourceType GetSourceld GetActicn GetPa

>

string:0, symbol:0

[CAPINUMISCRL

In the Script field, enter the text of the script in JScript programming language (see Examples of scripts in

JScript language).
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4. Run the script using a test event. To create a test event, select Debug and edit — Edit test event.
The Test message window will open containing the fields for setting the event parameters.

@
L)

File View Debug and edit List

> ELE O E

)

Scrint

H- Script messages
= Debug-edit script
- Seript 1

Ready

/]

Test message

SourceType

‘ MACRO

Sourceld

‘ 1

SourceAction

‘ RUN

param ‘ value

o]

Cancel

rceld GetActicon GetPa

To run the script using the test event, select Debug and Edit — Test run.

( Note

You can also run the script using the test event using the Ctrl+T key combination.

Features when working with a script

CAP |NUM |SCRL

When working with script in the Editor-Debugger utility, you can undo the last action or return the last action. To
undo the last action, press the Ctrl+Z key combination. To return the last action, press the Ctrl+Y key combination.

( Note

For your convenience, when editing the script, the cursor position is saved when saving the script or when
switching between the scripts in the Editor-Debugger utility window during a session, i.e. until Axxon PSIM

is restarted.

() Note

When you go to the Script messages list when editing the script, and then go back to the corresponding
script in the Debug-edit script list, you cannot undo or return the last action.
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Debugging a script

You can check if the script syntax is correct using the interpreter which is built-in into the Editor-Debugger utility.
The result of the check with the information about the content and location of the error is displayed in the
Debugger window corresponding to the script in the Script messages list. If there are errors, you need to edit the
script syntax and check it again.

(@ Note

See the detailed information about using test events for script debugging in Script debugging.

After debugging the script using the Editor-Debugger utility, run it with a real system event. Check the result of the
script execution. If the result is incorrect, make the necessary changes and run the script again.

Script creation is considered complete if it runs correctly.

5.6.2 Saving a script

The Editor-Debugger utility provides two options for saving scripts - in a Script object, or in a text file on the hard
drive.

To save the script in the Script object, in the File menu, select Save in the database. When this item is selected, the
script is updated on every Server selected on the Script object settings panel (see The Script object).

() Note.

Also, use Ctrl+S hotkey to save the script in the database.

() Note

The script is automatically saved in the corresponding Script object upon closing the Editor-Debugger
utility.

To save the script in the file, in the File menu, select Save on disk. To open a script saved in a file in the Editor-
Debugger utility, in the File menu, select Open from disk.

5.6.3 Deleting a script

To delete a script created in the Axxon PSIM system, delete the corresponding Script object in the Programming
tab.

5.6.4 Search textin script
The Editor-Debugger allows searching text in script using a dialog box.

Press Ctrl+F to open search dialog box. The Find dialog box opens.
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Find 1 6 X

Find what: ﬁ
_ Concsl |
7

I~ Match whole word only @ [~ Direction Cancel
[ Match case 3 . Cup & Q"'"‘."”

4 ]

Enter the text to find in the Find what: field (1).
Set the Match whole word only checkbox to search for the text in whole (2).
Set the Match case checkbox to case-sensitive search for the text (3).

Select the direction of search through the text relatively to the current cursor position: Up (4) or Down (5).
Click Find Next to run search or go to the next entry (6).
6. Click Cancel to stop search and close the dialog box.

o=

The found match is highlighted in the Editor-Debugger utility window.

Script
if (Ewvent.SoutceType == "PFEOPLE_COUNTER" && Event.Sourceld == "N" &&
= i
ESIM_“?EI ("counter_i"};

= P5IM var ("counter k"):

it+r

P5IM var("counter_ i")=i;

Find =

I Match whole word only Direction Cancel

I Match case .f'“gp « D

5.6.5 Replace textin script

The Editor-Debugger allows replacing text in script using a dialog box.

Press Ctrl+H to open replace dialog box. The Replace dialog box opens.

Replace
Find what: | 1
Replace with: 1 2

[~ Match whole word only 3

Cancel
[T Match case 4

B,

1. Enter the text to find in the Find what: field (1).
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Enter the text to replace the found text with in the Replace with: field (2).
Set the Match whole word only checkbox to search for the text in whole (3).
Set the Match case checkbox to case-sensitive search for the text (4).
Click Find Next to run search or go to the next entry (5).

The search runs down from the current cursor position.

6. Click Replace to replace the current found match (6).

7. Click Replace All to replace all matches automatically (7).

8. Click Cancel to stop close the replace dialog box (8).

Example of use fo replacing variableito s:

1. Before replacement:

Script
if (Event.SoutceType == "PEQPFLE COUNTER" && Event.Sourceld = "N" &&
= {
i= PSIM var ("counter i"):
= P5IM war ("counter k"):
i++s
P5IM var ("counter i")=i;
Replace *
Find what:  |i Find Next
Replace with: Is Beplace
Replace Al
i Cancel
[~ Match case 4]
2. After replacement:
Script
if (Event.SoutceType == "PEOQOPLE COUNTER" &£& Event.Scurceld == "H" &g
= {
s= PSIM var ("counter i");
k= P5IM var ("counter k");
S++;
P5IM war ("counter i")=s;
Replace >
Find what: |i Find Next
Replace with: is Replace 1
Replace All
Cancel
[ Match case
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5.7 Programming tools

5.7.1 The Script object
The Script object is designed for initializing and setting the parameters of JScript scripts in Axxon PSIM system.

Figure shows the settings panel for the Script object.

Architecture Hardware Interf Users Programming

ECurity zone . Run on
3 - Scipt 1
i Computer Mame
Tirme schedules [ Dizable

Timers
= <Y Scripts

d computers

[ DESKTOP-F9. LOCALHOST

£y Script 2 [2]
| "o Programs

g Objects links

B\ Access Levels

Editar - Debugger

Object type D Object name

Qru do

A Attention!

Creating of large number of the Script objects (more than 100) can result to unstable system working.

The settings panel allows choosing the time zone and the computers (kernels) for executing the script.

(@ Note.

To set all checkboxes checked select one in the column and click Ctrl+A. To set all checkboxes unchecked
select one and click Shift+A.

It also has the button for starting the Editor-Debugger tool and the text window for viewing the script text created by
means of this tool. The scripts can be edited in the Editor-Debugger tool or directly in the settings panel for the
Script object.

Moreover, one can configure the filter of events - the list of events which are to be processed by the Script system
object. Including the event to the filter equals to if operator in the text of script, i.e. when the event is in the table,
the operator can be omitted.

Programming in JScript- 75



PSIM 1.0.0-1.0.1 (english) - Programming Guide (JScript)

& Attention!

The event filter is to be set when creating a script in large distributed configurations. Otherwise, the
module will process all incoming events and it will lead to module malfunctioning.

() Example

If the Object’s type column has the Macro value, the Identifier column has the 1 value and the Event
column has the Executed value, then

if (Event.SourceType == "MACRO" && Event.SourceId==1 && Event.Action == "RUN")
{

DoReactStr("CAM", "2", "REC", "");

1

script can be used instead of script.

DoReactStr("CAM", "2", "REC", "");

The detailed information on the elements of the settings panel for the Script object is given in
Administrator's guide.

() Example.

Recording on Camera 1 is to be started when controlling PTZ device in the Video surveillance monitor.
For this, adjust the Script object as follows:
1. Select the required time zone when the script is to be executed.
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2. Enterthe script text:

Computer Mame

M Disable 4 DESKTOP-73. LOCALHOST

if (Event.SourceType == "MACRO" &£& Event.Sourceld==l1 && Event.Action
{

DoReactStr ("CaM", "2", "REC™, ""};

|+

iun an epecified computers

Editar - Debugager

Obiject type D Obiject name Event
CORE DO_REACT

Undo

3. Adjust thefilter as follows:

1. Select CORE in the Object’s type dropdown list.
2. Enter DO_REACT in the Event field.

The filter can be set by the UPDATE_OBJECT event of the CORE object. Example command to add Camera 1 object
to the Script 2 filter:

NotifyEventStr ("CORE","","UPDATE_OBJECT",
"objtype<SCRIPT>,0objid<2>,EVENT.objid.0<1>,EVENT.0objid.1<10>,EVENT.action.count<2>,fl
ags<>,EVENT.action.0<>,EVENT.action.1<>,EVENT.objtype.0<CAM>,EVENT.objtype.count<2>,E
VENT.objtype.1<CAM>,EVENT.objid.count<2>");

5.7.2 The Editor-Debugger utility

The Editor-Debugger utility is designed for creating, debugging and editing scripts in the Axxon PSIM software
package.

Figure shows the Editor-Debugger dialog window.
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=10l
File View Debugandedit Listofevents Help
[PEBEDE|2Es> D
[#- Script messages V*ﬂ:tion Sonrceld ScourceTypse GetSourcelvpe GetSourceld GetA
Iél--DEbug-editsa'ipt if (Event.SourceType == "GRELE" && Event.Sourceld == "1")
‘e Soript 1 = {
wvar msgevent = Event.Clone ()
if (Event.Action == "QOHNH")
= {
megevent.Sourceld = "2";
DoReact (msgevent) ;
magevent.Sourceld = "3";
DoReact (msgevent) ;
}
if (Event.Action == "0OFF")
= {
megevent.Sourceld = "2";
DoReact (msgevent) ;
}
}
KN 1L
string:0, symbol:0 Hlm SCRL ¢

The Editor-Debugger utility contains the built-in text editor and the debugger window.

To help with writing correct codes, the text editor automatically highlights objects, methods and properties in
different colors. In addition, the code blocks can be collapsed or expanded with - or + buttons in the left of the
Script text field.

if (Event.SonrceType =

o=l IR
if (Ewvent.SourceType ==
= i
() Note.

When switching between scripts, script messages or other objects in the Editor-Debugger utility tree, the
collapsing settings are reset, i.e. all blocks in the script become expanded.

The position of the cursor in each script is stored in the context of one Axxon PSIM session (the cursor position is

reset at the product restart). For example, if you place the cursor at the end of //Line 2 in Script 1, then switch to
Script 2 and perform any action in it, the cursor will be still at the end of //Line 2 when you return to Script 1.
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% script 1
File Wiew Debugandedit Listofevents Help

s BEHDE|2ma T P
B9 Fsaript
¥ Seript messages A*Action Sourceld
E--ngug—edits-:ript SALine 1
- Saript 2 //Line] 2|
“- Saript 1 A/Line 3

The debugger window allows viewing the information about all events registered by the system. You may filter the

events to be shown in the debugger window. A separate debugger window is created for each Script object, which
allows each script to be debugged individually using the filters.

To debug the script, it is possible to test run using a user-defined test event generated by the utility and not
registered in the system. To display or edit this event, select Debug and edit -> Summary Information, and then go

to the Trial event tab on the panel that opens at the bottom of the window. For details, see Creating and using test
events.

5 =10l %]
File WView | Debugand edit Listof events Help
J ip [ Testrun EI
- Test run with a debugger 'pt
—  Edittestevent - - — — p— — — -
..Sgiptm. S ——— I_f*ﬂ:ti:-r. Sourceld Sourcelype GetSourceType GetSonrceld Gefil
El--D:abug—E P if (Event.SourceType == "GRELE" && Event.Sourceld == "1")
e ST {
var m=sgevent = Event.Clone () ;
if (Event.Action == "ON")
o {

msgevent . Sourceld
DoReact (msgevent) ;
megevent.Sourceld = "3";
DoReact (msgevent) ;

}

GRELE|EVENT|ON [

4
4] 4] »] w|™, Script messages » Trial event /

Summary information

Scripts can be saved as Script objects or as text files on the hard drive.

5.7.3 The Debug window

Axxon PSIM allows viewing all events and reactions happening in the system in real time mode. Events and reactions

with object properties are displayed in the Debug window. They can be copied to the Windows clipboard and then
used in programs.
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Enabling the Debug window

By default the debug window is disabled. To enable the debug window, do the following:

1.
2.

o

8.

Shut down Axxon PSIM.
Run the Tweaki.exe utility.

() Note

The Debug window can be enabled without the tweaki.exe utility. For this set values 1, 2 or 3 for the
Debug string parameter in the HKEY_LOCAL_MACHINE\SOFTWARE\AxxonSoft\PSIM section of the
Windows registry (HKEY_LOCAL_MACHINE \Software\Wow6432Node\AxxonSoft\PSIM for 64-bit
system).

Select Axxon PSIM section in the tree on the left side of the utility dialog box.
Change the value of the Debug mode parameter from Disabled to Debug 1, Debug 2, Debug 3, or Debug 4.

Any of these modes will enable the Debug window, the difference between them is in the amount of

information written to the log files (see The Settings panel of the Axxon PSIM section).
Click the OK button.
Start Axxon PSIM.

A new Debug window item appears on the Main control panel of Axxon PSIM.

L5
ooo

Macro 1
)| About program...
() Debugwindow

|| System settings

Log off (User 1)

(@ Note

This menu is also available in the Windows notification area (system tray)—left click on the EI
button or short click the F8 hot key.

Macro 1

About program...

Debug window

| System settings

Log off (User 1}

Select the Debug window item on the Main control panel in order to display the Debug window on the
monitor. The selected Debug window item is marked with a flag.
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Macro 1
) About program...
v Debug window

System settings

Log off (User 1)

To hide the Debug window, re-select the Debug window item on the Main control panel.

(@ Note

To disable the Debug window, select the Disable value for the Debug mode in the tweaki.exe utility or set
value 0 for the Debug string parameter in the HKEY_LOCAL_MACHINE\SOFTWARE\AxxonSoft\PSIM section
of the Windows registry (HKEY_LOCAL_MACHINE \Software\Wow6432Node\AxxonSoft\PSIM for 64-bit
system). These actions are performed when Axxon PSIM is exited.

Working with Debug window

Look at the figure of the Debug window. The Debug window displays the sequence of events and reactions in the
system.

[N Debug window

Clear Colors Filter [ apply filter [ use regex Search

Event : SLAVE|DESKTOP-7932GG9|PING [Save_id <DESKTOP-7932GGY =, owner <DESKTOP-79326G9 > module <video.run >, date <28-12-22 ver_type<0=,guid_pk<{8596A954-7E85-ED 11-BSEF-9439E5349C
Event : SLAVEIDESKTOP-7932GG3 |PING |slave_id <DESKTOP-7932GG9 >, owner <DESKTOP-7932GG5 >, module <video.run >, date < 28-12-22 >, ver_type<0=,guid_pk<{E0DAS5573-7E56-ED 11-B3EF-9439E5349¢C
Ewvent : CAM|1|CLOSE_FILE|slave_id <DESKTOP-7932GGS >, fraction <840, owner <DESKTOP-7932GG59 >, module <video.run >, date < 28-12-22 >, guid_pk«<{2A98E37E-7E86-ED 11-BBEF-9439E5349CDE} =, core,_
Ewvent : CAM|2|CLOSE_FILE|slave_id <DESKTOP-7932GG9 >, fraction <840 ,owner <DESKTOP-7932GG9 > ,module <video.run > date <28-12-22= guid_pk<{2B98E37E-7E86-ED 11-BSEF-9439E5349CDE} =, core_
Event : CAM|1|OPEN_FILE |slave_id <DESKTOP-7332GG9 >, fraction <872 > owner <DESKTOP-7332GG9 > ,module <video.run>,date « 28-12-22 > guid_pk <{2C38E37E-7ES6-ED 11-B8EF-9439E5349CDE} =, core_y
Ewvent : CAM|2|OPEN_FILE |slave_id <DESKTOP-7932GG9 >, fraction <872 > owner <DESKTOP-7932GG9 > module <video.run >, date < 28-12-22 > guid_pk <{2D38E37E-7E86-ED 11-B8EF-9439E5349CDE} =, core_y
Event : SLAVE|DESKTOP-7932GGY |PING |slave_id <DESKTOP-7932GG9 > owner <DESKTOP-7932GG9 > module <video.run >, date <28-12-22 > ver_type <0 guid_pk<{2B5C018C-7E86-ED 11-B8EF-9439E5349¢C
Event : SLAVE|DESKTOP-7932GG9|PING |[save_id <DESKTOP-7932GGY =, owner <DESKTOP-79326G9 >, module <video.run >, date <28-12-22 ver _type<0:=,guid_pk<{50DC 199F-7E86-ED 11-B8EF-9439E5349¢
: SLAVE|DESKTOP-7932GG9|PING |slave_id <DESKTOP-7932GG9 >, owner <DESKTOP-7932GG9 >, module <video.run >, date <28-12-22 > ver_type<0>,guid_pk<{C97D6DB 1-7E86-ED 11-B8EF-9439E5349

Here are the features of the Debug window:

1. always on top;

the size of the Debug window is changed using the mouse;

information on event or reaction can be copied to the Windows clipboard and then used in programs;
events and reactions can be filtered in the Debug window;

events and reactions can be highlighted in the Debug window;

itis possible to search for events or reactions in the Debug window.

ouhswnN

Regular expressions can be used in order to highlight and filter messages in the Debug window.

Copying information on event or reaction to the clipboard
To read and/or copy data on event or reaction to the Windows clipboard, do the following:

1. Highlight the required line in the Debug window.
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2. Right-click on the highlighted line. The Info window with info on required event or reaction appears.
| 3 pe W - O X

Clear | Colors | Filter | [ apply filter

-

|| Event: CAM|1|OPEN_FILE|slave_id <DESKTOP-7932GG2 =, fraction < 0>, guid_pk <{A6C00DCS5-7F86-ED 11-B3EF-2439E5349CDE} > core_

Event : CAM|2|OPEN_FILE|slave _id <DESKTOP-7932669 >, fraction < b> guid_pk < {A7C00DC 5-7F86-ED 1 1-B8EF-3439E 5349CDE} = core _
|| Event : SLAVE|DESKTOP-7932GG8 |PING |slave_id <DESKTOP-7932GG! ver_type <0 auid_pk<{365004CB-7F86-ED 11-B8EF -B433E5340C
Event : SLAVEIDESKTOP-7932GG9|PING |slave_id <DESKTOP-79326G ver_type <0,auid_pk<{FDAC19DE-7F86-ED 11-B3EF-9439E5345¢
|| Event : SLAVE|DESKTOP-79326GS |PING [slave _id <DESKTOP-7932GG! ver_type <0,guid_pk<{251F2DF 1-7F85-ED 11-B8EF -B439E5349C
|| Event : SLAVEIDESKTOP-79326G3 PING [slave_id <DESKTOP-7932GG: ver_type<0x,auid_pk<{71254204-8086-ED11-BAEF-9439E5349C

Event : SLAVE|DESKTOP-79326G9 |PING |slave_id <DESKTOP-7932GG | ver_type <0 quid_pk < {SEAES617-5085-ED11-B5EF -0433E5349C
|| Event : SLAVEIDESKTOP-7932GG9|PING slave id <DESKTOP-7932GG! ver_type<0>,auid_pk<{11ASDE23-8085ED11 BSEF-9439E5343¢

VE|DESKTOP-7932GG3|PING [slave_id <DESKTOP-79326G! \ver_type <0>,guid_pk <{88C38737-8086-ED 1 1-B8EF-3433E 5349

3. Highlight the information that is to be copied to the Windows clipboard and click Ctrl+C.

() Note.
Use the context menu for operations with text in the Info window (right-click on the highlighted
text).
4. To close the Info window, click the N button.
Information on event or reaction is now copied to the Windows clipboard.
Highlighting messages

To configure message highlighting in the Debug window, do the following:

1. Click the Colors button.
M Debug window

Clear | Colors Fiter | []Apply filter [Juse regex Search

Event : SLAVE |DESKTOP-7932GG3 |PING |slave_id <DESKTOP-7932GG9 = ,owner <DESKTOP-7932GG9 >, module <video.run > date < 28-12-22> ver_type
Event : SLAVE|DESKTOP-7932GG3 |PING |slave_id <DESKTOP-7932GGY = owner <DESKTOP-7932GG9 = ,module <video.run >, date < 28-12-22 >, ver_type
Event : CAM|1|CLOSE_FILE |slave_id <DESKTOP-7932GG9 >, fraction <683 = ,owner <DESKTOP-7932GG9 >, module <video.run >, date <28-12-22>,guid_|
Event : CAM|2|CLOSE_FILE |slave_id<DESKTOP-7932GG9 =, fraction <683 = ,owner <DESKTOP-7932GG9 >, module <video.run =, date <28-12-22>,guid_|
Event : CAM|1|OPEN_FILE |slave_id <DESKTOP-7332GG3 =, fraction <728 = ,owner <DESKTOP-7332GG3 » module <video.run = date <28-12-22 = quid_p
Event : CAM|2|OPEN_FILE |slave_id <DESKTOP-7332GG3 =, fraction <728 = owner <DESKTOP-7332GG3 » module <video.run = date <28-12-22 = quid_p
Event : SLAVE|DESKTOP-7332GG3 [PING |slave_id <DESKTOP-7332GGY = owner <DESKTOP-7932GG5 =, module <video.run =, date < 28-12-22 = ver_type
Event : SLAVE|DESKTOP-7332GG4 [PING |slave_id <DESKTOP-7332GGY = owner <DESKTOP-7932GG5 =, module <video.run =,date < 28-12-22 =, ver_type
: SLAVE |DESKTOP-7332GGA |PING |slave_id <DESKTOR-7332GG3 = owner <DESKTOP-7932GG9 >, module <video.run =, date
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2. In the Highlight in window specify the line that is to be highlighted every time it appears in the message (1).

E_Rin
o BB
HE NN
N NN
HE NN
Highlight L f .
iy |
Event I_I_I_l_
Start

| 4 Define Custom Colors >> |

[oc ]| concel

2 5 |

| |2 e B

Click the Color button (2).

Select the color in the Color common dialog box (3).
Click the OK button(4).

Repeat steps 2-5 for all required lines.

ou kAW

(@ Note.
To add a line to the table, click the v key on the keyboard.

7. Click the Yes button (5).

As a result messages with the specified line are highlighted in the Debug window.

W Debug window

The messages are now highlighted.

Event and reaction filter
The filter of events and reactions allows displaying only required messages in the Debug window.

To configure the filter of events and reactions, do the following:
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Clear Colors |

Filter

[ ] apply filter [Juse regex Search

Event : SLAVE|DESKTOP-7932GGS PING |slave_id <DESKTOP-7332GG5 =, owner <DESKTOP-7932GG9 = module <video.run=,date <28-12-22 =, ver_type
Event : SLAVE|DESKTOP-7932GGS PING |slave_id <DESKTOP-7332GGE5 =, owner <DESKTOP-7932GGY > module <video.run =,date <28-12-22 =, ver_type
Event : SLAVE|DESKTOP-7932GG9 |PING |slave_id <DESKTOP-7932GG9 =, owner <DESKTOP-7932GG9 > module <video.run =, date £28-12-22 =, ver_type
Event : SLAVE |DESKTOP-7932GG9 PING |slave_id <DESKTOP-7932GG59 >, owner <DESKTOP-7932GG9 > module <video.run =, date <28-12-22=,ver_type
Event : SLAVE |DESKTOP-7932GGS PING |slave_id <DESKTOP-7332GG5 =, owner <DESKTOP-7932GG9 = module <video.run =,date < 28-12-22 =, ver_type
Event : SLAVE|DESKTOP-7932GGS PING |slave_id <DESKTOP-7332GG5 =, owner <DESKTOP-7932GG9 = module <video.run =,date < 28-12-22 =, ver_type

: SLAVE |DESKTOP-7932GG3 |PING [slave_id <DESKTOP-7932GG9 > owner <DESKTOP-7932GG3 > module <video.run >, date
Event : SLAVE |DESKTOP-7932GGS PING |slave_id <DESKTOP-7932GG9 >, owner <DESKTOP-7932GG9 > module <video.run =, date <28-12-22=,ver_type
Event : SLAVE|DESKTOP-7932GGS |PING [slave _id <DESKTOR-7932GG3 > owner <DESKTOP-7932GG9 > module <video.run >, date < 28-12-22: ver_type .,

>

2. Inthe Filter window specify the lines that are to be in the message for it to be displayed in the Debug
window (1). You can use regular expressions in the line, in this case don't forget to set the Use regex

checkbox on step 5.

Filter

Enable

Ewent

Exdude

3

3. Specify the lines that are to be in the message for it to not be displayed in the Debug window (2). You can use
regular expressions in the line, in this case don't forget to set the Use regex checkbox on step 5.

(@ Note.

To add a line to the table, click the ¥ key on the keyboard.

4. Click the Yes button (3).
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5. If regular expressions were used in the filter lines, set the Use regex checkbox checked (1).

B Debug window

Clear Colors [ ] apply ﬁlter2 [Juse regex 1 Search

A

Event : SLAVE |DESKTOP-7932GG9|PING |slave_id <DESKTOP-7932GGS =, owner <DESKTOP-7332GG9 = module <video.rur
Event : SLAVE |DESKTOP-7232GG9|PING |slave_id <DESKTOP-7232GG9 =, owner <DESKTOP-7932GG9 = module < videa.rur

6. To apply the filter, set the Apply filter checkbox checked (2).
As a result only messages that fit the search criteria are displayed in the Debug window.

The event and reaction filter is now configured.

Searching for events and reactions
To search for events and reactions, do the following:

1. Click the Search button (1). The Search window appears.

Clear Colors Filter [] apply filter [Juse regex 1 Search

Event : SLAVE|DESKTOP-7232GG3|PING [slave id <DESKTOP-7332GGS = owner <DESKTOP-7932GG3 = module <video. rur
Event : CAM|1|CLOSE_FILE|slave_id<DESKRRLE. ®x 9
Event : CAM|2|CLOSE_FILE|slave_id<DESK]

Find what: | 2 | | Find Next

Event : CAM|1|OPEM_FILE|slave_id<DES o.r

Event : CAM|2|OPEM_FILE |slave_id<DES [ Bbekchcandle: wwowel iy 3 Direction Eomicel b.r

Event : SLAVE|DESKTOP-7232GG9|PING |sla D rur
Up (® Down ?

: 5LAVE |DESKTOP-7932663 PING s\ A kil 5

: SLAVE |DESKTOP-7932GG3|PING sla Fur
! : SLAVE |DESKTOP-7932GG3|PING [sla : - : T |,

2. Specify the search criteria in the Search for: field (2).

3. Ifthe specified string is to be searched as a whole word, not a part of any other word, then set the Match
whole word checkbox checked (3).

4. If the search is to be case sensitive, then set the Case sensitive checkbox checked (4).

5. Set the Direction switch into the position corresponding to the search direction (5).

6. To view the following search result, click the Find next button (6).

(@ Note.

To close the Search window click the Cancel button.
The search for events and reactions is now complete.

Clearing the Debug window

To delete all messages from the Debug window, click the Clear button.
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B Debug window
Clear I Colors ' Filter [ ] Apply filter [ ]use regex

Event : SLAVE|DESKTOP-7932GG3 |PING [slave_id <DESKTOP-7932GGS =, owner <DESKTOP-T932GG9 = module <video.rur
Event ; SLAVE|DESKTOP-7232GGS |PING |slave_id <DESKTOP-7932GG9 = ,owner <DESKTOP-7932GG9 >, module <video.rur
Event : SLAVE|DESKTOP-7932GG3 |PING [slave_id <DESKTOP-7932GGS = owner <DESKTOP-T932GG9 = module <video.rur
Ewvent : SLAVE|DESKTOP-7932GG9 |PING |slave_id <DESKTOP-7932GGS =, owner <DESKTOP-7932GG9 > module <video.rur
Event ;: CAM|1|CLOSE_FILE|slave_id<DESKTOP-7932GG9 >, fraction <887 > owner <DESKTOP-7932GG59 >, module <video,
Event : CAM|2|CLOSE_FILE |slave _id<DESKTOP-7932GG9 », fraction <887 > ,owner <DESKTOP-7332GG9 =, module <viden,
: CAM|1|OPEM_FILE |slave_id <DESKTOP-7932GG9 >, fraction <918 awner <DESKTOP-7932GG9 =, madule <video,

Event ; CAM|2|OPEM_FILE |slave_id <DESKTOP-7932GG9 >, fraction <918 >, owner <DESKTOP-7932GG9 >, module <video.r
Ewent : SLAVE|DESKTOP-7932GG9|PING |slave_id<DESKTOP-7932GG9 = owner <DESKTOP-7932GG9 >, module <video.rur .,
< >

5.7.4 Getting the list of object names, reactions and events in Axxon PSIM

The list of object names, reactions and events used while programming in Axxon PSIM software can be got with the
help of ddi.exe tool. See the description of the main system objects reactions in the Description of system object
reactions.

The ddi.exe tool is started in one of the following ways:

1. Start — Axxon PSIM — System configuration.

() Note

The ddi.exe tool is available in the Start menu with the following types of Axxon PSIM installation:
Server, Administrator’s workstation and Workstation for monitoring.

2. Inthe Tools folder of Axxon PSIM installation folder.
To view the list of object names, events and reactions, do the following:

1. Inthe tool, open psim.ddi file.
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2. Select the DDI tab on the left (1). The list of system objects is displayed here.
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File
DD [1DBI

ARCH
ARCHPANEL

ATM
ATMX25_CLIENT
ATMX25_SERVER
CAM

CAM_FACECAPTURE
CAM_IP_DETECTOR
CAM_TITLE

CAM_ECHD

CAM_VMDA
CAM_VMDA_DETECTOR
CAM_VMDA_DETECTOR2
CAM_ZONE

CONFIG

DEPARTMENT

DIALDG

DISPLAY

DMD

DRS
EVENT_COLUNTER
EVENT_VIEWER

GATE
GRABBER
GRAY
GRELE
HTTP
KEYB
LEVEL

LMCFTP
LMCGATE

MACRO
MAIL_MESSAGE
MAIN

MAP

MAPLAYER
MAPPLATFORM
MESSAGE

MMS
MONTOR

Names Events Reactions lcons  States Transfer rules
~

Search by name
|
Object Name Group name ~
O ———
ARCH Backup archive
ARCHPANEL Backup archive panel
ATM ATM
ATMX25_CLIENT ATM Clizrt
ATMX25_SERVER ATM Server
CAM Camera
CAM_FACECAPTURE Face Detection
CAM_IP_DETECTOR Embedded detection
CAM_TITLE Captioner
CAM_ECHD ECHD channel
CAM_VMDA Tracker
CAM_VMDA_DETECTOR VMDA detection
CAM_VMDA_DETECTOR2 Neuro Tracker VMDA detection
CAM_ZONE Detection zone Detection zones
CONFIG Conrfiguration Corfigurations
DEPARTMENT Department
DIALOG Operator query panel
DISPLAY Display
DMD Control of bamiers

Total objects: 83

3. Inthe DDI tab, select the object which events and reactions are to be viewed (2).

4. Toview the name of the selected object, go to the Names tab (3).

5. Toview the list of events for the selected object, go to the Events tab.
€ DDI & DBI Editor i

File
DDl DBl

Mame} Events

Reactions lcons  States  Transfer rules

ACTIVEX

ARCH

ARCHFAMNEL

ATM
ATM»25_CLIENT
ATMx*25_SERVER
CAM
CAM_FACECAPTURE
CAM_IP_DETECTOR
CAM_TITLE
CAM_ECHD
CAM_VMDA
CAM_VMDA_DETECTOR
CAM_VMDA_DETECTOR2
CAM_ZONE

CONFIG
DEPARTMENT
DIALOG

DISPLAY

DMD

DRS
EVENT_COLINTER
EVENT_VIEWER
GATE

GRAY

GRELE

HTTP

KEYB

LEVEL

LMCFTP
LMCGATE
MACRO
MAIL_MESSAGE
MAIN

GRABBER

MName Description

Parameters for event "UPS -

Processing  Support

messages audio

.| mror...

L+ ]
3 HEEEEEEEEE

Disable
network
connection

Disable Windows
logging log

:E_IIIIIIIIIII

y restored™:

power

Parameter Mame Type

| Element Value

Total objects: 88
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6. To view the list of reactions for the selected object, go to the Reactions tab.
% DDI & DB Editor - [C:\Program Fi n PSIM\Languages'en

File

DDl DBI Names Everfe Reactions fons States Transfermules

ACTIVEX ~ Reaction Description Aming region

ARCH !

ARCHPANEL 3 MUX1_OFF [Disable video out 1
ATM 3 )
ATM¥25_CLIENT MUX2_OFF Disable video out 2

é}mm_SEHVEH MUX3_OFF Disable video out 3

CAM_FACECAPTURE *
CAM_IP_DETECTOR
CAM_TITLE

CAM_ECHD

CAM_VMDA
CAM_VMDA_DETECTOR
CAM_VMDA_DETECTOR2
CAM_ZONE

CONFIG

DEPARTMENT

DIALOG

DISPLAY

OMD

DRS

EVENT_COUNTER
E:I-EFET-WENEH Parameters of action "Disable video out 1"

[

GRAY Parameter MName Type Element Value

GRELE . -
HTTP

KEYB

LEVEL

LMCFTP

LMCGATE

MACRO

MAIL_MESSAGE

MAIN v

O Qo

Total objects: 88

See the detailed information on working with ddi.exe tool in the Editing psim.dbi and psim.ext.dbi database
templates using the ddi.exe utility.

(@ Note

If the Sensor is armed, then at the Sensor switching on/off the Alarm event appears depending on the
alarm mode setting (see the Creating and configuring the Sensor system object section of the Installing
and configuring security system components guide). If the Sensor is disarmed, the Closed/Opened events
appear correspondingly.
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6 Appendix 1. Description of the Editor-Debugger utility

6.1 The purpose of the Editor-Debugger utility

The Editor-Debugger utility is designed for creating, debugging and editing scripts in the Axxon PSIM software
package.

The Editor-Debugger utility provides the following functionality:

1. Creating and editing scripts using the built-in text editor;
Debugging scripts using the built-in debugger window;

Filtering the information to be displayed in the debugger window;
Creating and using test events for debugging;

Saving scripts to the hard drive;

Opening scripts from the hard drive.

ouhswN

6.2 The interface of the Editor-Debugger utility

6.2.1 The Editor-Debugger window

The Editor-Debugger window contains the main menu, the toolbar (1), the object list (2) and the viewing/editing
panel (3).

% Script 2
File View Debugand edit List of events Help 1
»EIEHDE EE
"
- ly Script _\
E--Scriptmessages if (Event.SourceType = "MACRO" && Event.Sounrceld = "1" && Event.Action == "RUN") \
Script 1 =1
.. Script 2 var i;
. Script 3 for{i=1l; i<=4; i=i+l}
i - Script4 = {
4 . SetObjectParam ("CAM™, i, "hot rec time™,™10");
J=- Debug-edit script L 5 = =
. a i
----Scr?pt‘l _/— DebuglogString ("Hello world™):
- Seript 2 5
- Seript 3 :
- Script 4
\ JJ
2
\ : ol
A
string:0, symbol:0

6.2.2 The Script Debug/Edit tab

Description of the Script Debug/Edit tab
The Script Debug/Edit tab is used for editing scripts and creating test events.
Figure shows the Script Debug/Edit panel.
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@ Script messages
File View Debugandedit Listof events Help
n
- ettings message \
El- Script messages
Script 1 ¥, quid<{5BCE0780-8724-ED 11-B42C-80B655F8955C} =, time_zone < > SLAVE.slave_id.count<0>,1 »
o -
- Seript 2 SCRIFT|3|SETUR [parent_id < =,type<0:=,int_obj_id<3>,objname <Script 3=, EVENT.action.count=0:
.. i 1
Scr!pt : debugger; /J breakpoint
B DebugLogString {"Hello world™);
= Debug-edit script 1 ¥, guid <{75C4CE9F-BA23-ED 11-B42C-80B6 55F8955C } >, time_zone <=, SLAVE. slave_id.count<0,
=
SIS SCRIPT|2|SETUR parent_id< >, type<0>,int_obj_id<2>,objname <Script 2= EVENT.action.count<0:
- Script 2 {
.. Script 3 Var i;
crfp for(i=1; i0=4; i=i+1)
- Script 4 I
SetObjectParam{"CAM™,i, hot_rec_time™,"107);
DebuglogString (Hello world™);
},guid <{47B 1626F-B023-ED 11-842C-80B655FBI55C) =, time_zone < »,SLAVE.slave_id.count<0=E
S
Quantity of | 4
2 Quantity of unprocessed | 0
Priority of | MNORMAL_PRIORITY_CLASS
Table shows the description of the elements in the Script Debug/Edit panel.
Ne Field name Field Description Units Default Value
type value range
1 Settings message  Auto Script object Latin, Cyrillicand - -
initialization special symbols
information
2 Additional Auto Additional Latin, Cyrillicand - -
information information

special symbols
about scripts

The Script object panel in the Script Debug/Edit tab
The Script objects in the Script Debug/Edit tab are used for creating and editing scripts and test events.

Figure shows the Script object panel.

Appendix 1. Description of the Editor-Debugger utility- 90



PSIM 1.0.0-1.0.1 (english) - Programming Guide (JScript)

& Script 2 - O X
File View Debugandedit Listof events Help
»EIEDE [-]

q (ﬁ:ript \
El- Script messages if (Event.Sorcelype == "MACRO" &£& Event.Sourceld £& Event.Action == "RUH")

=

var i;
forfi=Ly d-ody A=1+1)
ot {

1 SetObjectParam ("CAM",i,"hot rec time","10");

DebuglogString ("Hello world"™);

\

< J

ffmput-Output o )
MACRO|T|RUN|
2
\ /
M| 4] »| w| % Script messages  Trial event
Ready CAP |NUM [SCRL

Table describes the elements in the Script object.

6.2.3 The Script Messages tab

Description of the Script Messages tab
The Script Messages tab is used to display the debugger windows for the scripts.

Figure shows the Script Messages panel.
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% Script messages
File View Debugandedit Listofevents Help

n
o ﬂ;tﬁngs MESSAgE \
E ¢ Script messages

= ~
-2l SCRIPT|4|SETUR [parent_id< =, type <0=,int_obj_id<4= objname <Script 4=, EVENT.action.count<0:
- Script 2
.. Scriot 3 {
crfp war msgevent = CreateMsg();
- Seript 4
B Debug-edit script msgevent. SourceType = "CUSTOM™;
-~ Seript | 1 msgevent.Sourceld = "1%
- Script 2
- Seript 3 msgevent. Action = "ON";
- Seript 4 MotifyEvent{msgevent);

¥z, quid <{5BC30780-8724-ED11-B42C-80B655F8955C} =, time_zone <>, SLAVE.slave_id.count<0,|

=
SCRIPT|3|SETUP |parent_id<>,type<0>,int_obj_id<3> objname <Script 3= EVENT.action.count=0: ,,

L >
(- B
Quantity of | 4
2 Quantity of unprocessed | i}
Priority of | NORMAL_PRIORITY_CLASS
. J

Table shows the description of the elements in the Script Messages panel.

Ne Field name Field Description Units Default Value
type value range
1 Settings message  Auto Script object Latin, Cyrillicand - -
initialization .
special symbols
information
2 Additional Auto Additional Latin, Cyrillicand - -
information information

special symbols
about scripts

The Script object panel in the Script Messages tab

The Script panels in the Script Messages tab are used to display system, test and user events related to the scripts
created in Axxon PSIM.

Figure shows the Script object panel.
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% Script 2

File View Debugand edit

List of events  Help

[pEHBE|2Le? P IO

n

Description

[ Script messages
Script 1

.- Script 3

i i Script 4

=8 Debug-edit script
- Seript 1

- Script 2

- Script 3

- Seript 4

DebuglegString-[Script:2], (1048):Helle world

Seript first run OK

Event End:MACRO|1|RUN|guid_pk<=, begin-end delay: 0 [msec]
Event Start MACRO[1|RUN|

DebuglegString-[Script:2], (1048):Hello world

Seript first run QK

Event End:MACRO|1|RUN|guid_pk=>, begin-end delay: 0 [msec]
Event Start MACRO[1[RUN|

DebuglegString-[Script:2], (1048):Hello world

Script first run OK

Event End:MACRO|1|RUN|guid_pk<>, begin-end delay: 15 [msec]
Event Start MACRO[1|RUN|

DebuglegString-[Script:2], (1048):Helle world

Seript first run QK

Event End:MACRO|1|RUN|guid_pk<=, begin-end delay: 0 [msec]
Event Start MACRO[1|RUN|
DebugLegString-[Script:2],(9224):Hello world

Script first run QK

Event End:MACRO|1|RUN|guid_pk<>, begin-end delay: 0 [msec]
Event Start MACRO[1|RUN|

DebuglegString-[Script:2], (4304):Helle world

Seript first run OK

Event End:MACRO|1|RUN|guid_pk<=, begin-end delay: 0 [msec]
Unable to CoCreatelnstance CLSID_ProcessDebugManager
Event Start MACRO[1|RUN|

DebuglegString-[Script:2], (4304):Hello world

Seript first run QK

Event End:MACRO|1|RUN|guid_pk=<>, begin-end delay: 0 [msec]
Unable to CoCreatelnstance CLSID_ProcessDebugManager
Event Start MACRO[1|RUN|

DebugLegString-[Script:2], (4304):Hello world

Script first run QK

Event End:MACRO|1|RUN|guid_pk<=>, begin-end delay: 0 [msec]
Unable to CoCreatelnstance CLSID_ProcessDebugManager
Event Start MACRO[1[RUN|

DebuglegString-[Script:2], (4304):Hello world

Seript first run OK

Event End:MACRO|1|RUN|guid_p , begin-end delay; 0 [msec]

Table describes the elements in the Script object.

6.2.4 Main menu

On the page:

+ Description of the main menu

+ The elementsin the File menu

+ Theelementsin the View menu

+ The elements of the Debug and edit menu
+ The Message list menu elements
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Description of the main menu

The Editor-Debugger main menu is used to call editing, debugging and other commands. The commands are
grouped into functional menus: File, View, Debug and edit, Message list and Help.

Table describes the elements of the main menu.

Ne Element name Element Description Units Default Value
type value range
1 File Drop-down Commands for - -
list of items opening

and saving scripts
and

closing the utility

2 View Drop-down Commands for - - -
list of items displaying the
toolbar and the
status
bar in the utility
window
3 Debug and Edit Drop-down Commands for script - - -
list of items debugging
4 Message list Drop-down Commands for - - -
list of items changing
the message display
parameters
in the debugger
windows
5 Help Drop-down The About command - - -
. . showing
list of items

general information
about

the Editor-Debugger
utility

The elements in the File menu
The File menu is used to open and save scripts and to close the utility.

Table describes the elements of the File menu.
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No. Element Element Description Units Default Value
name type value range
1 Save to database Item Saves the script - - -
in the object
2 Save to disk Item Saves the scriptinto
a text file on the hard
drive
3 Open from disk Item Opens the script file - - -
4 Exit Item Shuts down the utility - - -

and closes the window

The elements in the View menu
The View menu contains commands for showing and hiding the toolbar and the status bar.

Table describes the elements of the View menu.

Ne Element Element Description Units Default Value
name type value range
1 Toolbar Checkbox Shows or hides Boolean Checked Check - show
the toolbar toolbar
Uncheck - hide
toolbar
2 Status bar Checkbox Shows or hides Boolean Checked Check - show
the status bar status bar
Uncheck - hide
status bar

The elements of the Debug and edit menu
The Debug and edit menu contains the commands for debugging scripts.

Table describes the elements of the Debug and edit menu.
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Ne Element Element Description Units Default Value
name type value range
1 Test run ltem Runs the script with the - - -
test event
2 Testrun ltem Runs the script using - - -
the

in third-party
third-party debugger

debugger
3 Edit test event Item Opens the window for - - -
editing test events
4 Summary Item Opens the Thread - - -
. . Information
information
window showing
system, test and user
messages related to the
current script
5 Go to line Item Opens the window for - - -

entering the script

line and character
number to go to

The Message list menu elements
The Message list menu contains commands for changing the message display parameters in the debugger window.

Table describes the elements of the Message list menu.

6.2.5 The Filter dialog window

The Filter window allows to set the filtering criteria for the messages displayed in the Description field of the
debugger window.

To open the Filter window, do one of the following:

1. Click the Filter button k4 in the Editor-Debugger toolbar.
2. Inthe List of events, select Filter.

Figure shows the Filter window.
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Filter oo

—Enable

—Exclude

test

0K I Cancel

Table describes the elements in the Filter window.

6.2.6 The Color dialog window

The Color dialog window is used for setting up color highlighting of the lines containing certain words.

To open the Color window, do one of the following:

1]
1. Click the Colors button ™ in the Editor-Debugger toolbar.
2. Inthe Message list menu, select Colors.

Figure shows the Color window.
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Crrins
% scnpt 2

File View Debugand edit

|» BB E|2fee®

List of events Help

& [+ -]

s

Description

El- Script messages

P L Scri pt1

- Senipt 2

- Script 3

i . Scriptd

E| Debug-edit script
- Script 1

- Secript 2

- Seript 3

- Script 4

Ready

Event Start:SCRIPT|2|INITIEVENT. objtype.count<0>, guid <{47B1626F-B023-ED11-B42C-20BE
Script first run OK

Event End:SCRIPT]2|IMIT|guid_pk< >, begin-end delay: 0 [msec]
Event Start MACRO|T|RUN|

DebuglogString-[Script:2], (1048):Hello world

Script first run QK

Event End:MACRO1|RUM|guid_pk< =, begin-end delay: 0 [msec]
Event Start MACRO|T|RUN|

DebuglogString-[Script:2], (1048):Helle world

Script first run OK

Event End:MACRO1|RUN|guid_pk=< >, begin-end delay: 0 [msec]
Event Start MACRO|T|RUN|

DebuglogString-[Script:2], (1048):Hello world

Script first run OK

Event End:MACRO|1|RUM|guid_pk<>, begin-end delay: 15 [msec]
Event Start MACRO|T|RUN|

DebuglogString-[Secript:2], (1048):Hello world

Script first run OK

Event End:MACRO|1|RUN|guid_pk<>, begin-end delay: 0 [msec]

Highlight X

Str_ing I
holiday

- Color | oK I Cancel

Table describes the elements in the Color window.

6.2.7 The toolbar of the Editor-Debugger utility

The Editor-Debugger toolbar is used for calling frequently used functions of the utility.

The toolbar operates in two modes: when the script control buttons are active, or when the debugger window

control buttons are active.
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The mode depends on the currently active tab of the Editor-Debugger utility: either the Script Debug/Edit tab for
editing scripts, or the Script Messages tab for viewing messages in the debugger window.

Figure shows the toolbar in the script editing mode.

EIHRBE
1 2 345

Table shows the elements of the toolbar in the script editing mode.

Figure shows the toolbar in the script debugging mode.

XA
[ B

Table shows elements of the toolbar in the script debugging mode.
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7 Appendix 2. Creating custom objects with ability to set events,
reactions and states

7.1 Purpose of custom objects and their implementation in Axxon PSIM

Custom objects represent software emulation of new Axxon PSIM objects and allow configuring their states,
reactions and events. Custom objects are handled using scripts, macros and macroevents.

Custom objects are created using the ddi.exe and CustomTypeEditor.exe utilities in the <Axxon PSIM installation
folder>\Tools.

In the How to create a custom object section you can find an example of creating two types of custom objects that
can be used to show the state of abandoned object detection tool on the map or to show any other user states. The
states of objects are changed using macros, scripts, or via lIDK.

The procedure for creating and configuring a custom object:

1. Prepare the DBI file with the required types of objects.
2. Prepare the DDI file—it specifies the events, reactions, states and state transition rules for the newly created
objects.
. Prepare the XML file with the parameters of the newly created objects.
4. Update the main database using The idb.exe utility for converting databases, selecting database templates
and making backup copies of databases.
5. Create a custom object in Axxon PSIM.

w

7.2 How to create a custom object
Here one can find out how to create the following custom objects:

1. CUSTOM type with SLAVE (Computer) parent type.
2. CUSTOM_CHILD type with CUSTOM parent type (see item 1).

An object of the CUSTOM type has the property set:

Custom_param1 and custom_param2 parameters
Events: ALARM, INFO, ON, OFF
Reactions: ON, OFF
States: ON, OFF
State machine:
a. Set ON state for ON event
b. Set OFF state for OFF event

o=

The CUSTOM_CHILD type of the object is created to demonstrate tree structure and has no user parameters, events,
reactions or states.

7.2.1 DBIfile preparation

A DBl file is prepared using the ddi.exe utility. Details on how to handle it can be found in The ddi.exe utility for
editing database templates and external settings files section of Administrator's Guide.

A DBI file for the objects of the CUSTOM and CUSTOM_CHILD type is created as follows:

1. Run the dbi.exe utility (see The ddi.exe utility for editing database templates and external settings files).
2. Go to the DBI tab.
3. Create two objects—OBJ_CUSTOM and OBJ_CUSTOM_CHILD as shown in the figure below.
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& Attention!
Object (table) names should look like OBJ_<object type>.

@ DDI & DBl Editar *

- O x
File
DDl DBl Field name Type Size Description
0BJ_CUSTOM_CHILD .
name | CHAR - |60
parent_id |CHAR -6
flags INTEGER
quid | UNIQUEIDENTIFIER
custom_param1 TEXT
custom_param2 INTEGER
.
[OBJ_CUSTOM |
id, CHAR, 16

name, CHAR, 60
parent_id, CHAR, 16

flags, INTEGER

guid , UNIGUEIDENTIFIER
custom_param1, TEXT
custom_param?2, INTEGER

Total objects: 2

4. Setthe parameters for each object. The id, name, parent_id, flags, guid parameters are mandatory for all
objects. Custom_param1, custom_param2 in the example in the figure are custom parameters. You can
also set other parameters used in Axxon PSIM. For example, adding the region_id parameter will allow you
to set areas and regions for an object (see Subdivision of the protected facility into areas and regions).

5. Save the changes using the Save command in the File menu. The saved file must have the dbi extension and

must be located in Axxon PSIM installation directory, for example, C:\Program Files (x86)\Axxon
PSIM\PSIM.custom.dbi.

DBI file preparation is complete.

7.2.2 DDl file preparation

A DDl file is prepared using the ddi.exe utility. Details on how to handle it can be found in The ddi.exe utility for
editing database templates and external settings files section of Administrator's Guide.

A DDl file for CUSTOM and CUSTOM_CHILD object types is created as follows:

1. Run ddi.exe (see The ddi.exe utility for editing database templates and external settings files).
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2. Create CUSTOM and CUSTOM_CHILD objects in the DDI tab as shown below.

@ DDI & DB Editor * - [} X
Fil

Mames Events Reactions lcons States Transferrules

M
CUSTOM_CHILD Search by name

Object Name Group name
» Witual ohject
CUSTOM_CHILD Child virtual object

Total objects: 2

3. Go to the Events tab and configure events that are to be supported by the object (see the figure).

@ DDI & DEI Editor * — O x
File

Dol DBI Mames Events Reactions lcons States Transfermles

Processing Disable network

C ]
CUSTOM_CHILD | MName Description Support audio Disable logging Windows log

messages connection

Parameter Name Type | Element Value

Total objects: 2

4. Go to the Reactions tab and configure reactions that are to be supported by the object (see the figure).

() Note

Reactions of custom objects are automatically converted into events. In other words, a custom
object automatically generates an event when there is a reaction.
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@ DDI & DB Editor *

Names Events Reactions lcons States Transferrles
Aming region

Description
O
O

File
DDl DBI
CUSTOM Reaction
CUSTOM_CHILD
ON Enable
OFF Disable
. & |

Element Value

Type

Name

Parameter

Total objects: 2

@ DDI & DEI Editor *
File
Dol DBI Mames Events Reactions Icon:
CUSTOM Mame Image Description Blinking on alam
M_CHILD
»
off Disabled O
O

CUS
cusTo
OFF

Go to the States tab and describe the states that the object can take. Here there are two states - ON and
m] s

5.

Total objects: 2

() Note
The postfix of file name is specified in the Image column - the image that is stored in < Axxon PSIM
installation directory>\Bmp. For instance, these will be custom_off.bmp and custom_on.bmp files
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(corresponding to ON and OFF states) for CUSTOM object. These files will be used by the map
module.

6. Go to the Transition rules tab and set the object state change logic.

@ DDI & DB Editor * - [} X
File

Dol DBI Mames Events Reactions lcons States Transferrles

CUSTOM Event Move from state Move to state

CUSTOM_CHILD F

ON ~ |OFF ~ |ON -

| oFF -on - | oFF =

Total objects: 2
Transition rules is a simple state machine - an event is an input action and a state is a result.
An unconditional transition is used in this case: if CUSTOM||ON event is received, then there is transition to
the ON state, if CUSTOM||OFF event is received, then there is transition to the OFF state.

7. Tosave changes use the Save command in the File menu. The saved file must have the ddi extension and be
stored in the folder corresponding to the required language, e.g. C:\Program Files (x86)\Axxon
PSIM\Languages\en\psim.custom.ddi.

DDI file preparation is completed.

7.2.3 XML file preparation

An XML file is prepared using the CustomTypeEditor.exe utility that can be found in <Axxon PSIM installation
directory>\Tools. The utility overview is shown below.

5! Customn Type Editor

Eile

| obiect_type parent_type has_child

- - - o

An XML file for a custom object is created as follows:
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1. Specify the name of object type in the object_type field (1).

! Customn Type Editor

ol wn

File
object_type parent_type has_child
CUSTOM SLAVE
»  |CUSTOM_CHILD O
. L]
1 2 3

Specify the name of parent type in the parent_type field (2).

If the object type has child types, then set the has_child checkbox checked (3).

Repeat steps 1-3 for all object types.

Save the file with any name and .xml extension in the Axxon PSIM installation directory using the File - Save

command. For example, the "CUSTOM.xml" file name is recommended for the object shown on the picture

above.

The XML file is now created. The file contents look like this:

<?xml version="1.0" standalone="yes"?>

<objects>

<object>

<object_type>CUSTOM</object_type>

<parent_type>SLAVE</parent_type>

<has_child>1</has_child>
</object>

<object>

<object_type>CUSTOM_CHILD</object_type>

<parent_type>CUSTOM</parent_type>

</object>
</objects>

Modify it manually if required.

In particular, the <include_parent_id>1</include_parent_id> parameter can be added for a child object. When
setting this parameter to 1, the IDs of the child virtual objects will include the ID of the parent object. For example, if
a CUSTOM object has a child CUSTOM_CHILD, and the CUSTOM has ID = 3, then CUSTOM_CHILD objects will be

created with identifiers 3.1, 3.2, etc.

7.2.4 Creating and using a custom object in Axxon PSIM

On the page:
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« Displaying on the map

« Usingin macros

« Sample programin
JScript to change the
state of a custom object

& Attention!

After preparing the required files and before creating custom objects in Axxon PSIM, it is necessary to
update the main database using The idb.exe utility for converting databases, selecting database templates
and making backup copies of databases.

When the DBI, DDI and XML files are ready, the objects of a new type along with the standard objects can be created
in Axxon PSIM hardware tree.

Programming

ATM
£ Audio card
Expand tree /2| Audio playback card
Backup archive

Collapse tree ) _
Backup audio archive

Camera discovery tool | BacMet

Control device
Custom Object

Create folder... Data replication service

Delete ohject

Event counter
Save

Find...

Failover service
27 HTTP-server
Send key to all =4 |IDK Interface
Incident server
Intercom Subsystern

15D integration server

Load configuraticn...

Save configuration...

Keyboard
LDAP service

Custom parameters are displayed on the settings panel of the created custom object—custom_param1l and
custom_paramz2 in this example. Their values can be set in the table.
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Architecture Hardware Interfaces Users Programming

et
Computer Wl Dizable custjaramE
LOCALHOST i

Displaying on the map

When an object is created in the hardware tree it can be placed on the map and set reactions can be executed in the
object context menu (see Configuring the interactive map for object state indication and controlling the objects).

Custom Object 1 [1]

Show last events

Cn
Off

Using in macros

When a custom object is created in the hardware tree it can be used in macros.
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[ Disable F Il

. Lacal . Hidden

Parameters

Ewent Mame Walue
Action executed

Parameters

Type Mu..  Mame Mare Walue
Cuztom Object 1 Cusztomn Object 1

Apply Undo

() Note

Reactions of custom objects are automatically converted into events. Thus, in the sample, when the ON
reaction is executed, the object state changes due to set state transition rules (see DDI file preparation)
and the icon corresponding to the state will be displayed on the map.

Sample program in JScript to change the state of a custom object

Problem. Using macro 1 change the state of a custom object 1 to ON and display the icon corresponding to this
state on the map.

Solution. As state transition rules are set, when the ON event is sent from the custom object, the state will be
automatically changed to ON and the icon specified in ddi file (see DDI file preparation) to this state will be
displayed on the map. A script for sending the ON event looks like this:

if (Event.SourceType == "MACRO" && Event.Sourceld == "1" && Event.Action == "RUN")

{
var msgevent = CreateMsg();
msgevent.SourceType = "CUSTOM";

msgevent.Sourceld = "1";
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msgevent.Action = "ON";

NotifyEvent(msgevent);
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8 Programming Guide (JScript). Conclusion

More detailed information on the Axxon PSIM software package is presented in the documents titled:

1. Installing and configuring security system components guide.
2. Operator’s Guide.
3. Administrator’s Guide.

If while operating the given software product you have faced difficulties and problems, you are welcome to contact
us. However before addressing us, we kindly ask you to answer the following questions:

1. Whatis the problem?
2. When did the problem occur and what had happened before it occurred?
3. Which conditions gave rise to the problem?

Remember, that the more detailed and precise information you give us, the faster our experts will resolve your
problem.

We are striving to improve the quality of our products, and hence welcome any proposals and suggestions how to
improve our software and documentation.
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